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User's License Agreement

Important

Please read the following agreement carefully. This user's license agreement (hereafter
referred to as Agreement) is a legal contract between the software user (individual or institu-
tion) and HIOKI E. E. CORPORATION (hereafter referred to as HIOKI). The term "software"
includes any related electronic documentation and computer software and media, as well as
any printed matter (such as the Instruction Manual).

By installing, reproducing, or using the software, you, the Licensee, agree to accept the
license terms set forth in this Agreement.

This software is protected by copyright laws, international copyright agreements, as well as
non-corporate laws. The software is a licensed product, and is not sold to the user.

License

This Agreement grants you, the Licensee, a license to install a single copy of the software on
a specified computer system.

Explanation of other rights and restrictions

. Restrictions on reverse engineering, decompiling, and disassembling:

You may not reverse engineer, decompile, or disassemble the software.

. Separation of components:

This software is licensed for use as a single product. You may not separate the components
for use on multiple computer systems.

. Loaning:

You may not loan or lease the software.

. Transfer of software:

You may transfer full rights in accordance with this Agreement. However, if you do so, you
may not retain any copy of the software, but must transfer the software in its entirety (all com-
ponents, media, related documentation such as the Instruction Manual, and this Agreement),
and must ensure that the receiver of the software agrees with the terms set forth in this
Agreement.

. Cancellation:

In the event that the terms and conditions set forth in this Agreement are violated, HIOKI
retains the right to cancel this Agreement without compromise of any of its other rights. In this
event, you must destroy all copies of the software and its components.

Copyright

The title and copyright rights concerning the software's related documentation, such as the
Instruction Manual and copies of the software, are the property of HIOKI and other licensors,
and are protected by copyright laws and international agreement regulations. Accordingly,
you must treat the software as you would any other copyrighted document. However, you are
permitted to make copies as indicated in (A) and (B) below provided such copies are not
intended for use other than back-up purposes.

(A) You may make a single copy of the software.

(B) You may install this software on a single computer.

However, you may not reproduce the documentation supplied with the software, such as the
Instruction Manual.




Dual media software

You may receive the same software on more than one type of media. However, regardless of
the type and size of media provided, you may only use one media type and only on a single
computer. You must not use or install the other media on any other computer. Furthermore,
except when transferring the software as stipulated above, you may not loan, lease, or trans-
fer the other media to any other user.

Warranty

. HIOKI reserves the right to make changes to the software specifications without any

prior warning.

. If the software does not operate in accordance with the supplied Instruction Manual,

or the software media or Instruction Manual are damaged in any way, you have one
year from the date of purchase to apply for either an exchange or repair at HIOKI's
discretion.

. In no event will HIOKI be liable for any damages resulting from fire, earthquake, or

actions of a third party under the conditions stated in item number 2 above, or for any

damage caused as a result of your using the software incorrectly or under unusual

circumstances. Further, the warranty is invalid if the following occurs:

(A) Damage incurred through transport, moving, droppage, or any other kind of impact after
you purchased the software.

(B) Damage incurred through any form of alteration, unwarranted servicing, or any other type
of mistreatment.

. In the event that the software is exchanged or repaired, the period of warranty

expires on the latest occurring date out of the day stated in the original warranty, and
exactly 6 months from the day the exchanged/repaired software is returned to you.

. Regardless of the grounds for making a legal claim, HIOKI and its licensors will not

be liable for any damage incurred (including, but not limited to: lost profits, suspen-
sion of business, loss of data or lost savings) unstated in the warranty terms for the
use of this software. This is true even if HIOKI is notified of the possibility of such
damages. In any event, HIOKI's liability shall be limited only to replacing defective
software with software that is not defective.




Introduction

Thank you for purchasing this HIOKI "9335 WAVE PROCESSOR". To get
the maximum performance from the unit, please read this manual first, and

keep this at hand.

Trademarks

Microsoft and Windows, Windows Vista, Microsoft Excel are either
registered trademarks or trademarks of Microsoft Corporation in the United
States and other countries.

Notes on Use

In order to ensure safe operation and to obtain maximum performance from
the unit, observe the cautions listed below.

® Always hold the disc by the edges, so as not to make fingerprints on the
label side or scratch the printing.

® Never touch the recorded side of the disc. Do not place the disc directly
on anything hard.

® Do not wet the disc with volatile alcohol or water, as there is a possibility
of the label printing disappearing.

® To write on the disc label surface, use a spirit-based felt pen. Do not use a
ball-point pen or hard-tipped pen, because there is a danger of scratching
the surface and corrupting the data. Do not use adhesive labels.

® Do not expose the disc directly to the sun's rays, or keep it in conditions
of high temperature or humidity, as there is a danger of warping, with
consequent loss of data.

® To remove dirt, dust, or fingerprints from the disc, wipe with a dry cloth,
or use a CD cleaner. Always wipe radially from the inside to the outside,
and do no wipe with circular movements. Never use abrasives or solvent
cleaners.

® [n the interests of ongoing product developments, there may be minor
discrepancies between screen displays and the operating instructions, and
in the data conversion process.

® HIOKI cannot accept any responsibility for the results of using this
product.

The following symbols are used in this Instruction Manual to indicate the
relative importance of cautions and warnings.

NOTE Denotes items of advice related to performance of the
equipment or to its correct operation.

Notes on Use
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Chapter 1
Overview

1.1 Product Overview

The 9335 WAVE PROCESSOR offers the following features:

1. Waveform display

The waveform files recorded by the HIOKI MEMORY HiCORDER can
be displayed on a PC monitor. The displayed waveform data can be
magnified or compressed and scrolled. Even large-capacity waveform files
can be loaded and displayed at high speed.

2. Print

The waveforms recorded by the HIOKI MEMORY HiCORDER can be
printed in detail, along with hard copies of the waveform window
produced from a printer.

3. Search function

The date/time, voltage levels, maximum and minimum values, and any
other necessary data can be searched.

4. Numerical operation

Average value, maximum value, standard deviation, and various other
data can be obtained by calculation.

5. Text convert function

The waveform files recorded by the HIOKI MEMORY HiCORDER can
be converted into text format for processing by such spreadsheet software
as Microsoft Excel®.

6. X-Y synthesis

The waveform data can be X-Y synthesized before being displayed on the
screen.

1.1 Product Overview



1.2 Specifications

General specifications

Supplied media

One CD-R

Operating environment

PCs running Windows.

1 GHz or faster 32-bit or 64-bit processor, and 2 GB RAM

Video capabilities with 1024 x 768 resolution or higher and 256 or more colors
Minimum hard disk space required for installation 20 MB or more
CD-ROM drive required (used for installation)

oS

Windows 7 (32bit/64bit), Windows 8 (32bit/64bit), Windows 10
(32bit/64bit)

Supported recorders

HIOKI 8807-01, 8808-01, 8807-51, 8808-51,
8714-01, 8715-01, 8730-10, 8731-10

HIOKI 8870-20, 8870-21, MR8870-20, MR8870-30,
MR8880-20, MR8880-21

HIOKI 8826, 8835, 8835-01, 8841, 8842, 8720,
8860, 8861, 8860-50, 8861-50 (Can not load the waveform
data with different sampling rates)

Compatible input units:

8936 ANALOG UNIT, 8937 VOLTAGE/TEMP UNIT,

8938 FFT ANALOG UNIT, 8939 STRAIN UNIT, 8940 F/V UNIT,

8946 4ch ANALOG UNIT, 8947 CHARGE UNIT

8956 ANALOG UNIT, 8957 HIGH RESOLUTION UNIT,

8958 16ch SCANNER UNIT, 8959 DC/RMS UNIT,

8960 STRAIN UNIT, 8961 HIGH VOLTAGE UNIT

HIOKI 8855

Compatible input units:

8950 ANALOG UNIT, 8951 VOLTAGE/CURRENT UNIT,
8952 DC/RMS UNIT, 8953-10 HIGH RESOLUTION UNIT,
8954 VOLTAGE/TEMP UNIT, 8955 F/V UNIT

HIOKI 8825

Compatible input units:

8907 ANALOG UNIT, 8908 TEMPERATURE UNIT,
8909 FFT ANALOG UNIT

HIOKI 8840

Compatible input units:

8916 ANALOG UNIT, 8917 DC/RMS UNIT,

8918 TEMPERATURE UNIT, 8919 FFT ANALOG UNIT,
8928 STRAIN UNIT

HIOKI 8847, MR8847-01, MR8847-02, MR8847-03, MR8847A,
MR8827, MR8740, MR8741

Compatible input units:

8966 ANALOG UNIT, 8967 TEMP UNIT, 8968 HIGH RESOLUTION
UNIT, 8969 STRAIN UNIT, 8970 FREQ UNIT, 8971 CURRENT UNIT,
8972 DC/RMS UNIT, 8973 LOGIC UNIT, U8974 HIGH VOLTAGE
UNIT, MR8990 DIGITAL VOLTMETER UNIT

1.2 Specifications




Supported recorders HIOKI MRS8875, MR8875-30

Compatible input units:

MR8&901 ANALOG UNIT, MR8902 VOLTAGE/TEMP UNIT,

MR8903 STRAIN UNIT, MR8904 CAN UNIT, MR8905 ANALOG UNIT

HIOKI MR6000, MR6000-01

Compatible input units:

8966 ANALOG UNIT, 8967 TEMP UNIT,

8968 HIGH RESOLUTION UNIT, 8969/U8969 STRAIN UNIT,

8970 FREQ UNIT, 8971 CURRENT UNIT, 8972 DC/RMS UNIT,
8973 LOGIC UNIT, U8974 HIGH VOLTAGE UNIT,

U8975 4CH ANALOG UNIT, U8976 HIGH SPEED ANALOG UNIT,
U8977 3CH CURRENT UNIT, U8978 4CH ANALOG UNIT,

U8979 CHARGE UNIT, MR8990 DIGITAL VOLTMETER UNIT

HIOKI MR8740T

Compatible input units:

8966 ANALOG UNIT, 8967 TEMP UNIT,

8968 HIGH RESOLUTION UNIT, 8969/U8969 STRAIN UNIT,
8970 FREQ UNIT, 8971 CURRENT UNIT, 8972 DC/RMS UNIT,
8973 LOGIC UNIT, U8974 HIGH VOLTAGE UNIT,

U8975 4CH ANALOG UNIT, U8977 3CH CURRENT UNIT,
U8978 4CH ANALOG UNIT,

U8979 CHARGE UNIT, MR8990 DIGITAL VOLTMETER UNIT,
U8991 DIGITAL VOLTMETER UNIT (4CH)

1.2 Specifications



Function specifications

® File loading

Loadable data format

MEMORY HiCORDER files

Memory functions ("mem" file extension)

HI-Speed functions ("mem" file extension)

Normal measurement data ("mem" file extension) (only MR6000
MEMORY HiCORDER)

Recorder functions ("rec" file extension)

Realtime functions ("rec" file extension) (only MR8880
MEMORY HiCORDER)

Envelope measurement data ("rec" file extension) (only MR6000
MEMORY HiCORDER)

RMS functions ("rms" file extension)

Power functions ("pow" file extension)

XY Recorder functions ("xyc" file extension) (only 8847
MEMORY HiCORDER)

Maximum loadable file
size

Maximum size handled by supported MEMORY HiCORDER
(The size of files that can be handled may be smaller, depending
on the PC's operating environment.)

Overwrite save

Possible (Existing files can be overwritten with title comments,
channel comments, and scaling data.)

Partial Save

Partially save the waveform data between section-specifying cursor
(excluding MR8875, 8860, MR6000, MR8740T MEMORY
HiCORDER)

® Text conversion

Data conversion format

Selectable from CSV format, text (tab separated), text (space
separated), COMTRADE format(1991) or NMEA 0183 format
(COMTRADE format: only MR6000, 8860 MEMORY
HiCORDER)

(NMEA 0183 format: only MR8875 MEMORY HiCORDER)

Applicable data

All data or data between cursors

Data interleaving

Data can be interleaved at fixed intervals

Conversion method

Analog waveform data is converted into voltage values

Pulse waveform data is converted in integration or revolution
values

Logic data is converted into binary values (1 or 0).

Conversion channels

Selectable

Header contents

Title, trigger date/time, time-axis range, comments, setting
conditions for each channel

Collective conversion

Specified multiple files can be converted simultaneously.

1.2 Specifications




® Display

Waveform display

Shows waveform data images.

May be scrolled along the time-axis.

May be magnified or compressed along the time-axis.
Allows repositioning of the zero position or
magnification/compression of one channel at a time.
Supports variable settings on each channel.

X-Y synthesis display

Possible in "MEM", "REC" (envelope off) , "POW", or "XYC"
function format.
A range of data to synthesize can be specified.

Digital display

Digital values can be displayed for waveform data.

Cursor function

Two cursors (A and B) can be manipulated independently.
Time value and voltage value display

Maximum displayed
channels

256 analog channels
32 calculation channels
2 pulse channels

128 logic channels

Gauge display

Time gauge (selected from absolute time, relative time, seconds, or
data count)

Voltage-axis gauge (maybe shown or hidden for each separate
channel)

Diagram input

May be entered at any position.
Text, line, arrow, circle, or square

Copy to clipboard

Waveform screen (bitmap format/extended meta format)
Cursor value, digital value, file information, or calculation result
(text format)

Search function

Date/time search, maximum search, minimum search, level search,
or window search

® Numerical Calculation

Calculations

Average value, RMS value, P-P value, Maximum value, Time-to-
Maximum value, Minimum value, Time-to Minimum value,
Standard Deviation, Time-to-Specified Level, Area value, Integral
value, Sum, Rise Time, Fall Time, Period, Frequency, Pulse
Width, Duty, On counts, Off counts, On Time, Off Time,
Operating Rate

Calculation Range

All data, specified range, between AB cursor

1.2 Specifications




® Printing

Compatible printers

The printers supported depend on the OS being used.
Color and monochrome print possible

Print range

All data, screen-displayed range, or specified range

Print format

Not divided; divided by 2, 4, 8, or 16; 2, 4, 8, or 16 columns;
XY1 screen, XY2 screen, or XY4 screen

Gauge; channel comments can be set to print

0 position comment, AB cursor value, event mark can be set to print

Print preview

Possible

Waveform screen hard Possible
copy
Logging print Possible

® Other

Tool function

Any executable file registered can be executed.

Load in sequence

Load a waveform file in the folder in sequence.

1.2 Specifications




| ~

Chapter 2
Setup

2.1 Minimum System Configuration

The 9335 requires the following hardware and software:

Computer main unit

® OS: Windows 7, 8 or 10

® | GHz or faster 32-bit or 64-bit processor, and 2 GB RAM

® Minimum free hard disk space: 20 MB (used for installation)

® CD-ROM drive (used for installation)

® Display unit capable of displaying with a resolution of 1024 X 768 dots or
higher (using small fonts) and 256 or more colors

NOTE To load data from the MEMORY HiCORDER into your computer, you must have
PC card, SD card or USB drives. To load waveforms, you must have sufficient free
space on your hard disk for the waveform data.

2.1 Minimum System Configuration



2.2 Installation and Uninstallation

Installation
Install the 9335 software by following the procedure below:
1. Close all currently active applications.
2. Insert the CD-R included with your package into the PC's CD-ROM drive.
3. Run the SETUP file from the CD-R.
For example, if your CD-ROM drive is drive R (if not, use the letter
representing the CD-ROM drive on your computer), select "Start" - "Run"
from the Windows® menu, enter R:\9335ENG\setup.exe, then click <OK>.
4. This launches the 9335 installer. Follow the instructions displayed on
screen.
® When running anpther application, you may be }mable‘ to install the 9335 software.
Close all applications that can be closed before installing the 9335 software. In
particular, virus protection software may inhibit installation. In such cases, set up
the virus protection software to permit installation.

e When upgrading versions, uninstall the old version of 9335 before installing the
new version of 9335. After installation, confirm the version information on the
"Help" menu.

® The 9335 software may not be registered on the Start menu, depending on your
computer's operating environment. In such case, start "Wpro.exe" directly from the
folder in which it was installed.

Uninstallation

To uninstall the 9335 software, follow the procedure described below:

1. Close all currently active applications.

2. Insert the CD-R included with your package into the PC's CD-ROM drive.

3. Run the SETUP file from the CD-R.
For example, if your CD-ROM drive is drive R (if not, use the letter
representing the CD-ROM drive on your computer), select "Start" - "Run"
from the Windows® menu, enter R:\9335ENG\setup.exe, then click <OK>.

4. This launches the 9335 uninstaller. Follow the instructions displayed on
screen.

2.3 Starting and Quitting the Wave Processor

Starting the Wave Processor
Select "Programs" - "HIOKI" - "9335 Wave Processor" - "9335 Wave
Processor" from the Windows® Start menu.

Quitting the Wave Processor
Select "File" - "Exit" from the Wave Processor menu. Otherwise, click the
close button at the upper-right corner of the main window.

2.3 Starting and Quitting the Wave Processor
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Chapter 3
Waveform Window

3.1 Loading Waveform Files

The waveform window is displayed when you load any waveform file

"mem", "rec", "rms", "pow", or "xyc" file extension) recorded with the

MEMORY HiCORDER.

1. Select "Open Waveform File" from the "File" menu to display the "Open
File" dialog box.

2. Select the desired file to load and click the "Open" button.

About waveform settings files

Closing the loaded waveform file (by clicking the close button at the upper-
right corner of the main window to close all windows) automatically creates
a settings file (".hps" file extension) under the same name as the loaded file
in the same folder containing the loaded file. Opening the waveform file will
now load the settings file automatically, with the saved settings reflected in
the loaded file, provided that a settings file with the same name exists in the
same folder. If you do not want to load these settings, manually delete the
settings file.

Halting waveform drawing

The system may require some time to redraw waveforms representing large
amounts of data. To abort waveform drawing, press the Esc key on the
keyboard. Click the "Update" button on the toolbar to redraw the waveform
window.

Loading large files

Very large waveform files may not be loadable by Windows® due to limited
system resources. In such case, close all other active applications, then try
reloading. Depending on the specific configuration of your computer, you
may still be unable to load the waveform file.

3.1 Loading Waveform Files
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3.2 Working in the Waveform Window

The waveform window is displayed when you load a waveform file.

Slide Function
The Slide Function allows you to display waveforms
saved in the same folder one after another in order.

= DEMO.MEM
Fi Er A i Toolz  Window Help __Menu bal’
(E-HHI B3R S8 0E0 ¢ 28 AT md el B | I+ Main toolbar
Sample Waveform i Tltle .
1 Double-click the
S| | — I I’y e - [ Voltage1 (GHIIV] left mouse
Voltage-axis L e e A O e eaz CHoIN button to enter
auge | A A N M (c2) any desired
95 ] AN AN LN e character string.
Vo i o1
+50m-|
] 7\ v FAY v 7 i/ &gg Channel marker
/ / \‘|| { \ / @ D47 Channel legend
Voltagel : / \ ! J\ / \
=Rl f \ i\ 4 /
Waveform I ) ] 1 /
display JANAN / \ / \
] \ / \ /
S0 / \ SN N \
| § / <(GHE |
] v ¥
-100m | |——— i ——— —i ————h n—'—@ Cursor display
Time-axis range
= Os 500ms 1s 1.5s 2s 25s ShOWS the
gauge . ] waveform range
[2=] 8855 (1. MEM [ Z 100ms Gms) | (D) 10000V : 10z €0001) [ 1) 06-07-20 13209200 [-T2 0% [ [12 Os to 10s | v enclosed by
o | [amioee 13m0 | ;| CUISOrs A and B
Mai It s b or interval
ain status bar cursors.
Scroll bar

Lets you scroll the waveform. You can also
use the left/right keys or mouse wheel (for

Waveform screen status bar . ;
mouses provided with a wheel) to scroll.

Displays from left to right the model name, measurement function,
time-axis range (sampling period), recording length (data counts),
trigger date/time, pretrigger, judgement result and waveform data
display range.

* For time-axis representation, you can select "DIV" (see Section 3.2.4,
paragraph 5). Data counts per division vary with the MEMORY HiCORDER
model, so refer to the user's manual provided with your model.

3.2 Working in the Waveform Window
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3.2.1 Waveform Window Menu

The waveform window contains the following menus:

[File] ——[Open Waveform File]: Loads a waveform file. (See 3.1.)
—[Convert All]: Converts all waveform data into text. (See 4.1.)
——[Convert Between Cursors]: Converts a specified section of data into text. (See 4.2.)
——[Batch Conversion]: Converts multiple specified waveform files into text. (See 4.3.)
——[Save Waveform File]: Saves a waveform file over the existing file. (See 3.1.)
——[Screen Print] [Print]: Prints a waveform screen. (See 6.1.1))

—E [Preview]: Shows a preview of the printed waveform window. (See 6.1.2.)
[Page Settings]: Sets screen print. (See 6.1.3.)
——[Waveform Detail [Print]: Prints waveforms in detail. (See 6.2.1.)
Print] E[Preview]: Shows a preview of the detailed print. (See 6.2.2))
[Page Settings]: Sets detailed printing. (See 6.2.3.)

—[Printer Settings]: Sets a printer.

——[Exit]: Terminates Wave Processor.

[Edit] T[Capture Waveform Screen]: Copies the waveform window to the clipboard. (See 3.14.)
[Capture Settings] : Sets a screen hard copy. (See 3.14.1.)

[View] ——1——[Waveform View]: Opens another instance of the waveform window.
——[Logging View]: Displays waveform data numerically. (See 3.13))
—[XY View]: Displays waveform data on XY axes. (See Chapter 5.)
—— [Waveform Control]: Displays the Waveform Operations dialog box. (See 3.9.1.)
— [Waveform Info]: Shows amp and other information for each channel. (See 3.6.)
— [Time-Axis Cursor]: Displays the Time-Axis Cursor dialog box. (See 3.3.)
— [Volt Cursor]: Displays the Voltage Cursor dialog box. (See 34.)
— [Section Cursor]: Displays the Interval Specify Cursor dialog box. (See 3.5.)
— [Search]: Displays the Search dialog box. (See 3.7.)
—— [Parameter Calculation]: Displays the Numerical Operation dialog box. (See 3.8.)
— [Toolbar] [Main Toolbar]: Show/hides the main toolbar.

[Wave Toolbar]: Show/hides the waveform window toolbar.

— [Status Bar] —[[Main Status Bar]: Show/hides the main status bar.
[Wave Status Bar]: Show/hides the waveform window status bar.

[Settings] —T———[Graph Settings]: Sets graphic waveform display. (See 3.2.5))
— [CH Settings]: Sets channel comments and scaling. (See 3.10.)
—[Display Range Settings]: Sets a range of data to be displayed in the waveform window. (See 3.2.6.)
—[Template]: Save or load a template file.

[Tools]— [Set Tools]

[Window] [New Window]: Opens another instance of the same window as the currently active window.
[Cascade]: Displays all windows in overlapping format.
[Tile]: Displays all windows one below another.
[Arrange Icons]: Lines up the minimized windows.
[Close]: Closes the currently active window.
[Close All]: Closes all windows.

[Help] —[About 9335 Wave Processor]

3.2 Working in the Waveform Window
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3.2.2 Main Toolbar

This is the toolbar in the main window.
All functions of the main toolbar are available in menus.
O O R o RS
1. 2. 3.4. 5. 6. 7. 8. 9.10.11.12. 13.14.1516.17.18.19.20. 21. 22.
1. Open Waveform File
Loads a waveform file. Click the arrow to the right of this button to see a
list of previously loaded files.
2. Convert All
Converts the entire range of waveform data into text.
3. Convert Between Cursors
Converts a specified section of data into text.
4. Batch Conversion
Converts multiple specified files into text.
5. Automatically Load a Template File
Load a waveform display condition template file automatically at loading a
waveform file.
6. Load a Template File
Load a waveform display condition template file.
7. Save a Template File
Save a waveform display conditions to a template file.
8. Screen Print
Prints a waveform screen.
9. Waveform Detail Print
Prints a waveform in detail.
10. Waveform View
Opens another instance of the waveform window.
11. Logging View
Displays waveform data numerically.
12. XY View
Displays waveform data on XY axes.
13. Time-axis Cursor
Displays the "Time-Axis Cursor" dialog box.
14. Volt Cursor
Displays the "Volt Cursor" dialog box.
15. XY Cursor
Displays the "XY Cursor" dialog box.
16. Section Cursor
Displays the "Section Cursor" dialog box.
17. Waveform info
Shows amp and other information for each channel.
18. Search
Displays the "Search" dialog box.
19. Parameter Calculation
Displays the "Parameter Calculation" dialog box.
20. Waveform Control
Displays the "Waveform Control" dialog box.
21. Tools
Allows you to start other applications. (For more information, see 3.11, "Using Tools".)
22. Exit
Terminates Wave Processor.

3.2 Working in the Waveform Window



3.2.3 Waveform Window Toolbar

This is the waveform window toolbar.
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1. Zoom Out/ In
Magnifies/compresses the time axis of the waveform screen.

2. Cursor A Operation Mode
Left-click (the left mouse button) anywhere in the waveform display area
when this button is enabled to move cursor A to that position. Hold down
the m key and left-click to move the voltage A cursor to that position.

3. Cursor B Operation Mode
Left-click anywhere in the waveform display area when this button is
enabled to move B to that position. Hold down the key and left-click
to reposition the voltage B cursor.

4. Section Start Cursor Operation Mode
Left-click anywhere in the waveform display area when this button is
enabled to reposition the interval start cursor.

5. Section End Cursor Operation Mode
Left-click (the left mouse button) anywhere in the waveform display area
when this button is enabled to reposition the interval end cursor.

6. Comment Operation Mode
When this button is enabled, you can enter or edit comments. The comments
do not track waveforms when scrolled.

How to enter comments

(1) Click the comment input operation mode button on the toolbar.

(2) Drag the mouse in the waveform display area (by holding down the left
mouse button and moving the mouse) to set the size of the comment
input box. Enter a character string in the comment box.

(3) After entering a comment, left-click outside the comment box to finish
entering comments.

(4) After entering comments, you can move the comment by dragging to
another position.

(5) To edit existing comments, point to the desired comment and double-
click the left mouse button while the comment input operation mode
button on the toolbar is enabled. Otherwise, right-click the desired
comment to display a popup menu, then use the popup menu to change
character colors and other display parameters.

7. Waveform Zoom Operation Mode

Left-click anywhere in the waveform display area when this button is

enabled to magnify the time axis, centering on that position. Otherwise, hold

down the key and left-click to compress the time axis.
8. Display Cursor A
Shows or hides cursor A.

9. Display Cursor B
Shows or hides cursor B.
10. Display Volt Cursor A
Shows or hides voltage-axis cursor A.

3.2 Working in the Waveform Window
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11. Display Volt cursor B
Shows or hides voltage-axis cursor B.

12. Graph Settings
Sets a waveform graph. (See 3.2.5.)

13. Split
The waveform window can be split into as many as four sections. An
approximate dividing line is shown in the window when you click the split
window button, so left-click at the appropriate position. This is convenient
when, for example, you want to observe the beginning and the ending parts
of the same waveform at the same time. Click the split window button again
to restore single-window display.

14. Update
Updates the waveform window.

3.2.4 Popup Menu

Right-click anywhere in the waveform window to display a popup menu.

[ZJ HIOKT 9335 Wave Processor - DEMO MEM

File Edit View Settings Tools Window Help
|2 RO PERGE SSDFO # Nl D w G| B[ wwonre 77 |
=T |

[ Wavetorm Screen <DEMO.MEM>

|a@ a8 8% Qllas A B|EEHR

<Sample Waveform> 100ms/DIV {1:5)

Sample Waveform i 3
2 8
+100m | 1 I — |[E Voltage1 G HIIV]
vl | |H Voltage2 (GHEMV]
[ (LC1)
A A A oo
1 g AN mace 7
) \ 7\ 7 a2 '
/ A / \ [ (LDa)
0“3: / / )\ \ / / \ : / f 3
4 = / } / \ /
A / h\ / \
] \ / \ / 9
“50m. / AN AV IR Y
J <CHE |
1 v b
1 [ I I i D1 |
100m | | | | i i ]‘__J—Hg 6
5. 0s 500ms 1s 155 2s 2.5s ’
| S e | I
|22 8855 [L.. MEM |7 100ms Gms) [(D) 10000V : 10s (0001} | 7/ 08-07-20 13:20:1200 [-1# 0% || [f2 O to 10s | 4
i [sos/7/22 [T,

1. Gauge display
Gauge Type Select the display method for the gauge from the following:

None No gauges are displayed.
Upper/Lower For channels that have gauges turned on, the gauge for the
channel with the smallest number is displayed. Voltage values are
displayed only above and below the gauge.
Detail For channels that have gauges turned on, the gauge for the channel
with the smallest number is displayed. Voltage values are displayed for
every five divisions.
Multiple For channels that have gauge display turned on, gauges are
displayed for as many channels as specified by gauge counts, beginning
with the channel with the smallest number. Voltage values are displayed

3.2 Working in the Waveform Window
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only above and below the gauge.
Multi-Detail ~ For channels that have gauge display turned on, gauges are
displayed for as many channels as specified by gauge counts, beginning
with the channel with the smallest number. Voltage values are displayed
for every division.
Show Zero Position Shows or hides zero position marker.
Gauge Counts For multiple gauge types, set the number of gauges you
want to display.
Channel Changes the display of channel information.
Numeric Format Changes the display method for voltage values.
Resize Changes the size (width) of the gauge display area. The display area
is enclosed in dotted lines. Drag the left and right-side squares (located near
the center of the area) to resize as desired.
Text Color Set the colors of the numeric values of the gauge.
Font, Vertical Font Set the fonts for the characters displayed on the gauge.
. Marker display
Cursor A to Search History marker Set to show or hide each marker.
Jump Scrolls the waveform window to a specified position.
. Title
Edit Edit the title character string.
Transparent Makes the background transparent.
Border Displays the border.
Text Color to border color 2 Changes the display color for each element.
Resize Changes the size (height) of the title display area. The display area is
enclosed in dotted lines. Drag the square located near the center of the
display area to resize as desired.
Font Changes the title font.
Property Sets the border color, style, etc.
. Waveform display window
Zoom In, Zoom Out Magnifies or compresses the window along the time-axis.
You can also select the time per division. Selecting All compresses the
waveform to fit in the window.
Show Waveform Shows or hides analog, pulse and logic waveforms
simultaneously.
Divide Graph Up to 16 graphs can be displayed.
Grid Shows or hides the horizontal line, horizontal auxiliary line, vertical
line, and vertical auxiliary line.
Jump Scrolls the waveform to the trigger point, post trigger point, cursor A
or B position, start or end position of an interval, or search position.
Color Sets waveform background color, grid line color, and auxiliary line
color.
. Time-axis display
Type Select the method of displaying the time axis from the following:
None Does not show time.
Upper/Lower Shows the time at both ends of the window.
Detail Shows the time at every 5 divisions.
Time Notation Sets the method of displaying time. Select from Date, Trigger
Time, Second, Data Number, or Div.
Resize Changes the size (height) of the time-axis display area. The display
area is enclosed in dotted lines. Drag the square located near the center of
the display area to resize as desired.
Text Color, Font Change the character color and font.

3.2 Working in the Waveform Window



16

6. Display cursor status
Show Cursor Status Shows or hides the cursor range.
AB Cursors Status Color, Section Cursor Status Color Set colors for each cursor
status.

7. Channel marker
Type Sets the content to be displayed for the channel marker.
Analog CH Marker, Pulse CH Marker, Logic CH Marker Shows or hides the
respective channel markers.
Resize Changes the size (width) of the channel marker display area. The
display area is enclosed in dotted lines. Drag the square located near the
center of the display area to resize as desired.
Text Color, Font Sets the character color and font used in the channel marker.

8. Waveform window periphery
Set Display Range (See 3.2.6.)
Zoom In, Zoom Out Magnifies or compresses the window along the time-axis.
Split Window The waveform window can be split into as many as four
sections. Equivalent to Split Window on the waveform toolbar.
Refresh Redraws the waveform window.
Show Shows or hides each display area.
Template Save or load a template file.
Capture Produces a hard copy of the screen according to the settings set in
Section 3.14.1, "Setting Hard Copy", which can then be pasted onto other
applications.
Background Color Set the window background color.
Toolbar, Status bar ~ Shows or hides each bar.

9. Display waveform legend
Channel Changes the display of channel information.
Show Waveform Shows or hides analog, pulse and logic waveforms
simultaneously.
Resize Changes the size (width) of the waveform legend display area. The
display area is enclosed in dotted lines. Drag the left and right-side squares
(located near the center of the display area) to resize as desired.
Text Color, Font Sets the character color and font of the waveform legend.

Hold down the key while right-clicking any channel to display a
menu described below.

Waveform Controll Displays the waveform operation window.

Show Waveform, Display Gauge Shows or hides waveforms or gauges.
(Gauges can only be displayed for analog or pulse waveforms.)
Waveform Color Sets waveform colors.

Graph Selects a graph to display the waveform.

Line Width Selects the line width of waveforms. (Available for analog or
pulse waveforms only)

Position Sets the logic waveform display position. (Available for logic
waveforms only)

Top Draws the waveform of the selected channel on top of all other
waveforms. (Available for analog waveforms only)

Hold down the key while right-clicking any channel to set waveform
color.

3.2 Working in the Waveform Window
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3.2.5 Setting Waveform Graphs

Set the display method for waveform graphs.
Click the "Set Graph'" button on the waveform window toolbar or select "Set
Graph" from the "Settings" menu to display the "Waveform Graph Settings"

dialog box.
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1. OK button
The new settings are reflected in the graph. The dialog box is closed.
2. Cancel button
The new settings are canceled (i.e., not reflected in the graph). The dialog
box is closed.
3. Apply button
The new settings are reflected in the graph, but the dialog box is not closed.

4. Select number of divided graphs
The graph can be divided vertically into as many as 16 smaller windows.
* Depending on the window size, not all graphs may be displayed.

5. Select gauge type
Select the voltage-axis gauge from "None", "Upper/Lower", "Detail",
"Multiple", or "Multiple-Detail".
None No gauges are displayed.
Upper/Lower For channels that have gauge display turned on, the gauge for
the channel with the smallest number is displayed. Voltage values are
displayed only above and below the gauge.
Detail For channels that have gauge display turned on, the gauge for the
channel with the smallest number is displayed. Voltage values are displayed
at every five divisions.
Multi For channels that have gauge display turned on, gauges are displayed
for as many channels as specified by gauge counts, beginning with the
channel with the smallest number. Voltage values are displayed only above
and below the gauge.
Multi-Detail For channels that have gauge display turned on, gauges are
displayed for as many channels as specified by gauge counts, beginning
with the channel with the smallest number. Voltage values are displayed for
every division.

6. Gauge counts
For multiple gauge types, set the number of gauges you want to display. For

3.2 Working in the Waveform Window
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channels that have gauge display turned on, gauges are displayed for
channels sequentially, beginning with the channel with the smallest number.
7. Channel select tab
Select the channels you want to set.
8. Show/hide channel
Select the check box for any channel to display the waveform for that
channel.
9. Waveform color setting button
Set the waveform color for each channel.
10. Show/hide voltage gauge
Select the check box for any channel to display the voltage gauges for that
channel. The number of gauges that can be displayed is limited by the gauge
type and gauge count set.
11. Select display graph
If the graph is divided, select a graph to use to display the waveform for
each channel.
12. Select line width
Select the line width of waveforms.

If you selected logic channels on the channel select tab, the
dialog box includes the following set items:
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13. Select display graph
If the graph is divided, select a graph you want to use to display the logic
waveform for each logic unit.

14. Select display position
Select the position at which to display the logic waveform for each logic
unit. If the graph is not divided, the top is "Posn1" and the bottom is
"Posn8". The number of positions that can be set varies with the number of
divided graphs.

3.2.6 Setting Display Ranges

You can set a range of waveform data you want displayed in the waveform
window. If you are loading waveform data for the first time, the entire range
of data is displayed.

Select "Change Display Range" from the "Settings" menu to display the "Set
Waveform Display Range" dialog box. Otherwise, double-click the "waveform

3.2 Working in the Waveform Window



19

data display range" area on the waveform window status bar to invoke the
dialog box.

The dialog box initially displays a range of data enclosed by the interval-
specifying cursor.

Set Waveform Display Hange

1
%} |Se|ection range ; -200ms [-1000) to 1.8% [3000)

Start 2| _|;|-2D|3ms

End 3. 900018

4. Beset | 5. 0K 6. Cancel

1. Display specifiable range

2. Set start point
Set the first point of the waveform data you want to display. The relative
time at that point (time from the trigger) is shown to the right.

3. Set end point
Set the last point of the waveform data you want to display. The relative
time at that point is shown to the right.

4. Reset button
The start and end points are reset to the entire data range.

5. OK button
The new settings are reflected in the graph. The dialog box is closed.

6. Cancel button
The new settings are canceled (i.e., not reflected in the graph). The dialog
box is closed.

3.3 Time-Axis Cursors

The time-axis cursors let you read the voltage values at the cursor positions
on each channel.

3.3.1 Manipulating Cursors

Click the "Display cursor A" or "Display cursor B" button on the waveform
toolbar to display time-axis cursors on the screen.

To move a cursor, drag the cursor marker or cursor in waveform window (by
holding down the left mouse button while dragging). Otherwise, click the
"Cursor A operation mode" or "Cursor B operation mode" button on the
waveform toolbar, then left-click at the desired position in the waveform
window.

3.3 Time-Axis Cursors
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Cursor markers

Al B
it i—t1—=CursorB
Cursor A ii_ _____

3.3.2 Displaying the Time-Axis Cursor Dialog Box

To read the time value at the cursor position and the voltage value on each
channel, display the Time-Axis Cursor dialog box.

Click the "Display time-axis cursor window" button on the main toolbar to
display the "Time-Axis Cursor"dialog box, or select "Time-Axis Cursor" from
the "Settings" menu to display the dialog box. Drag the edge of the dialog
box to resize.
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. Time value display

Shows the time value at the cursor position. Shown below is the frequency
for the time from the beginning of waveform data.

. Button for moving the cursor
. Cursors A & B time difference display

Shows the time difference between cursors A and B. Shown below is the
frequency for the time difference.

. Button for moving cursors A and B simultaneously
. Search position display

Shows the time value as search result. Shown below is the frequency from
the beginning of waveform data to the search position. (Refer to Section 3.7,
"Searching Waveform Data")

. Voltage value display

Shows the voltage values at the positions of cursors A and B on each
channel, and the difference in voltage values between both cursors. If search
results are available, the voltage values at search positions are also displayed.
Voltages on logic channels are indicated by binary values (1 or 0).

Popup menu

Right-click in the dialog box to display a popup menu.

Copy cursor position Copies the time values at the cursor positions to the
clipboard (from where they can be pasted onto "Notepad" or other
applications).

Copy selected channel Copies the voltage values on selected channels in the
voltage value display area to the clipboard. Left-click to select a channel.
Hold down the Ctrl or Shift key while left-clicking to select multiple

3.3 Time-Axis Cursors
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channels.

Copy all Copies the time values at cursor positions and the voltage values for
all channels to the clipboard.

Numeric display Sets the format in which to show voltage values. Select from
"Exponential", "Floating-point", or "Auxiliary unit". Display of the unit of
measure can be turned on or off.

Maximum value/minimum value, Mean value May be selected when the type of
waveform data is the recorder function (".rec" file extension), realtime
function (".rec" file extension) (envelope on) or rms value function (".rms"
file extension). The voltage values are shown as maximum and minimum
values, or as a mean value.

Move to search position Moves cursor A or B to the search position.

3.4 Voltage Cursors

The voltage cursors let you read the voltage values for specified channels.

3.4.1 Manipulating Cursors

Click the "Display voltage cursor A" or "Display voltage cursor B" button on
the waveform toolbar to display voltage cursors on screen.

To move the cursor, drag the cursor marker or cursor in the waveform
window (by holding down the left mouse button while dragging). Otherwise,
click the "Cursor A operation mode" or "Cursor B operation mode" button on
the waveform toolbar and hold down the key as you left-click at an
appropriate position in the waveform window to move the cursor.

Cursor markers<:

3.4.2 Displaying the Voltage Cursor Dialog Box

__——Cursor A

__——Cursor B

To read the voltage values at cursor positions, display the "Volt Cursor"
dialog box. Click the "Display voltage cursor window" button on the main
toolbar to display the dialog box, or select "Volt Cursor" from the "View"
menu to display the dialog box.
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1. Time value display
Shows the voltage values for specified channels.
2. Button for moving the cursor
3. Cursors A & B voltage difference display
Shows the voltage difference between cursors A and B.

3.4 Voltage Cursors
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4. Button for moving cursors A and B simultaneously

5. Select channel
Select the channel whose voltage you want to see.

Popup menu

Right-click in the dialog box to display a popup menu.

Copy cursor value Copies the voltage values at cursor positions to the
clipboard (from where they can be pasted onto "Notepad" or other
applications).

Exponential, Floating-point, Auxiliary unit Sets the format in which voltage
values are displayed.

Show unit Turns the displayed unit of measure on or off.

3.5 Interval-specifying Cursors

Use the interval-specifying cursors to specify an interval from the beginning
to the end point of a waveform when performing text conversion, numerical
operations, or searches.

3.5.1 Manipulating Cursors

Interval-specifying cursors are displayed by default. If such cursors are not
displayed, right-click in the marker display area and select "Section Cursor"
from the popup menu.

To move the cursor, drag the cursor marker (by holding down the left mouse
button while dragging). Otherwise, click the "Interval start cursor operation
mode", or "Interval end cursor operation mode" button on the waveform
toolbar and click at an appropriate position in the waveform window to
move the cursor.

Interval start cursor marker

Sl. rlnterval end cursor marker

3.5.2 Displaying the Interval-specifying Cursor Dialog Box

Displaying the Interval-specifying Cursor dialog box lets you read the exact
positions of the interval-specifying cursors. You can also finely adjust the
cursor positions.

Click the "Display interval-specifying cursor window" button on the main
toolbar to display the "Section Cursor" dialog box, or select "Section Cursor'
from the "View" menu to display the dialog box.
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1. Interval start cursor position time value display
Shows the time value at the interval start cursor position.

2. Button for moving the interval start cursor

3. Interval end cursor position time value display
Shows the time value at the interval end cursor position.

4. Button for moving the interval end cursor

5. Interval-specifying cursors time difference display
Shows the time difference between the interval-specifying cursors.

6. Button for moving the interval-specifying cursors simultaneously

7. Shows data counts within the interval. Use this value as an approximate
amount of data when performing text conversion.

8. Interval start icon

9. Interval end icon
Popup menu
Right-click the interval start or interval end icon to display a popup menu.
You can use this popup menu to move the interval start or interval end
cursor to the position of cursor A or B, the beginning or ending position of
an interval, or the trigger or post trigger position, or search position.

3.6 Waveform Information Dialog Box

The information dialog box shows settings information for each channel.
Click the "Display waveform information window" button on the main toolbar
to display the dialog box, or select "Waveform Information" from the "View"
menu.

Popup menu

Right-click in the dialog box to display a popup menu.

Copy selected range Copies a selected range of information to the clipboard
(from where the information can be pasted onto Notepad or other
applications). Left-click to select a range. To select multiple ranges, hold
down the| Ctrl |or| Shift |key while left-clicking.

Copy all Copies all information to the clipboard.

3.7 Searching Waveform Data

You can search for waveform data by date/time, maximum/minimum value,
or voltage level. If you execute a search, the waveform window scrolls until
the search position is reached, with a search marker shown at the top of the
waveform window. The time value and voltage value at the search position

are displayed in the "Time-Axis Cursor" dialog box.

Click the "Display search window" button on the main toolbar to display the
Search dialog box, or select "Search" from the "View" menu.

3.7.1 Search by Date/time

3.7 Searching Waveform Data
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Specify a date/time or a time from the trigger before you search.

1. Click the "DATE/TIME" tab of the Search dialog box to display the date/time
search window.
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2. Enter any date/time or time from the trigger. "Date" and "Trigger time" are
interlocked.

3. Click the search button.
4. Click the Reset button to set the date/time at the trigger position.

Searching for event marks

If the waveform data contains an event mark, you can search for the position
of the event mark. The position of the specified event mark number is
displayed for "Date" and "Trigger time" in the dialog box.
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1. Event mark search check box
Selecting this check box lets you search for an event mark.
2. Event mark number input

Specify an event mark number. The position of the specified event mark
number is displayed for "Date" and "Trigger time" in the dialog box. The
event mark of the specified number in the waveform window is indicated by
an asterisk.

3. Event mark range

3.7.2 Search by Maximum, Minimum, Maximal, or Minimal
Value

You can search for maximum/minimum position or the maximal/minimal
position (convex/concave) on a specified channel.

3.7 Searching Waveform Data



25

1. Click the "MAX/MIN" tab of the Search dialog box to display the
maximum/minimum search window.

Search <Demo.mem> E3
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2. Set the range of search.
ALL Entire range of the waveform data
Selection Data in a section of waveform specified with interval-specifying
cursors

3. Select the method and channel. For maximal/minimal value searches, you
must also select a filter (in DIV units). The search uses moving-averaged
data (moving-averaged over as many divisions as specified for the filter).
This is useful when the waveform contains noise. If there are two or more
maximum or minimum values, the first maximum or minimum position
found by the search is used.

4. Click the search button to jump to the search position.

5. For maximal/minimal search, the system searches for the next point (to the
right) from the current search position each time you click the search button.
To repeat the search from the beginning of the waveform, click the Reset
button.

6. Click the backward search button during maximal/minimal search to, search
for the previous point (to the left) from the current search position.

3.7.3 Search by Level

You can search the position at which the waveform crosses a specified
voltage level (level-up or level-down) or the position at which the waveform
falls in or out of a specified voltage range.

1. Click the "LEVEL" tab of the Search dialog box to display the level search
window.

Search <Demo.mem> x|
search button

= Searchrange———————
backward search button /—’”I [G Al seecion | __Bet |

DATE/TIME | Masmin - LEVEL |

CH | Methac =] [ Tvee
L & 0OR  AND He;etl
DCa Ll g
EVEl
E | Methad Fiter[D 1]

O FCH4[K].. | Level Up
OEcHaH... Levelup | |levelUp  =]|OFF =]

O ECHEL].. | Level Up Lewel

FACH?M.. | Level Uc™
A ﬂ_l [
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2.

In the channel list, select the check box for the channel you want to search.
Multiple channels can be selected.

. Select a search condition. Note that search results differ when multiple

channels are selected, depending on the search condition.
OR A point at which conditions are met for one of the selected channels
AND A point at which conditions are met for all of the selected channels

. Set the search method for each selected channel. Left-click any desired

channel in the channel list to display the settings for that channel to the
right, allowing you to select the search method.

Level Up A point at which the waveform crosses the voltage specified for
"LEVEL" in the upward direction

Level Down A point at which the waveform crosses the voltage specified by
"LEVEL" in the downward direction

Window-in A point at which the waveform falls within the voltage range
specified by the upper and lower-limit values

Window-out A point at which the waveform goes out of the voltage range
specified by the upper and lower-limit values

If the selected channels are logic channels, specify a logic pattern.

High A point at which the data has the binary value of 1

Low A point at which the data has the binary value of 0

If you set a filter, no search is made unless the condition continues for as
many divisions as set for the filter. This is useful when the waveform
contains noise.

Click the Reset button to deselect the check boxes for all channels and to
reset the search method to the initial setting.

. Click the search button to jump to the search position.
. Each time you click the search button, the system searches for the next point

(to the right) from the current search position. To repeat the search from the
beginning of the waveform, click the "Reset" button.

. Click the backward search button to search for the previous point (to the

left) from the current search position.

3.8 Numerical Operation

Calculation execute
button

Calculation setting
button

Various calculations can be performed.

Click the "Parameter Calculation" button on the main toolbar to display the
"Parameter Calculation" dialog box, or select "Parameter Calculation" from
the "View" menu. Drag the edge of the dialog box to resize.

Parameter Calculation <Demo.mem:

J/&l & &l Selection AB Cursar |No calculation results

| avERaGE | AMS | PP | MazamuM | MasTIME[Sec] |

1 | i

For the recorder function, realtime function (envelope on) or rms value
function waveform data, calculations can be performed to find the "average
value, rms (root mean square) value, peak-to-peak value, maximum value,

3.8 Numerical Operation
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time for maximum value, minimum value, time for minimum value, standard
deviation, and time for level".

3.8.1 Setting Calculations

Set the calculation you want to perform and the channel on which you want
the calculation to be performed. In standard settings, all kinds of calculations
are performed on all channels.

1. Click the calculation setting button to invoke the "Calculation Settings"

dialog box.
Calculation 5ettings ]
Select Caleulation
[FAVERAGE [ Sk seting — |
- Loa
[IRMS BV - | | CH1
Cilay P Save
(] M LM Slops Up _I
[w]Md-TIME[Sec)
(] bAIMIRA LI R4 Filted[Dv] |OFF - =

(W MIN-TIME [Sec]
¥5TD. DEVIATION
[WILEVEL TIME[Sec]

Lewvel IU

AHEA Unit:[\f’]

WIRISE TIME[Sec] Rise/Fall]

(WIFALL TIME[Sec] 5 ok |
[/PERIOD[Sec] =

[w|FREQLIEMCY[Hz] ;I Cancel |

2. Select the check box for the calculation you want to perform.
Each calculation item is detailed below.

(1) Average value

Calculates the average value (V) of the waveform data.

n
1 .

AVE = — E di
n

i=1
AVE  average value
n number of data samples
di i-th data of the source channel

(2) RMS value

Calculates the RMS (effective) value (V) of the waveform data. When
scaling is used, the value is calculated after scaling.

n
RMS =/ % D) ai?
i=1
RMS effective value
n number of data samples
di i-th data of the source channel

(3) Peak-to-peak value

Calculates the peak-to-peak (maximum-minimum) value of the waveform
data.

(4) Maximum value

Calculates the maximum value of the waveform.

(5) Time for maximum value

3.8 Numerical Operation
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* Calculates the time interval to the maximum value of the waveform (in
seconds).

* If there are two maximum value points, the time to the first point is
calculated.

(6) Minimum value
Calculates the minimum value of the waveform.

(7) Time to minimum value

* Calculates the time interval to the minimum value of the waveform (in
seconds).

* If there are two minimum value points, the time to the first point is
calculated.

(8) Standard deviation

Calculates the standard deviation (V) of the waveform data.

n
o= % D (di - AVE)n)

1i=1

c standard deviation

AVE  average value

n number of data samples

di i-th data of the source channel

(9) Time for level

This operation searches from the beginning of the calculation range for the
point at which the waveform crosses the specified level, then finds the time
from the trigger at that point.

(10) Area value

Calculates the area bordered by the signal waveform and the zero position
(potential 0 V).

n
S= D [di|*h
=1

S Area value
n number of data samples
di i-th data of the source channel

h = At sampling period

/ /

/ %#Shaded area is calculated

Cursor A Cursor B

(11) Rise time
(12) Fall time
* From the captured waveform data, the 0% and 100% level is determined,

and the rise time (s) is taken as the time required to go from 10% to 90%
(fall time: from 90% to 10%).

3.8 Numerical Operation
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* In the captured waveform data, the first rising slope (or falling slope) is used
to make the calculation.

* When range cursors are used, the time calculated here is for the first
occurrence of a rising slope (falling slope) in the waveform interval enclosed
by the cursors.

Rise time
Fall time

It is possible to set values of the rise time (10% to 90%) and of the fall
time to (90% to 10%).

(13) Period

(14) Frequency

* Displays the period (s) and frequency (Hz) of the signal waveform.

* The calculation is performed by determining the middle point of the signal
amplitude and then measuring the interval from the point when that level is
crossed (in rising or falling direction) to the point when it is next crossed.

(15) Pulse width
Calculates the time difference between the point where the rising or falling
waveform intersects the set level and the intersection of the next opposite
slope.

(16) Duty Ratio
The ratio is calculated according to the time difference between the point
where the rising waveform intersects the set level and the intersection of the
next opposite slope. It can also be calculated according to the time difference
between the point where the falling waveform intersects the set level and the
intersection of the next opposite slope.

Tu-d
Duty Rato ——— x 100 (%)
Tu-d + Td-u

Tu-d: Time from rise to fall (s)
Td-u: Time from fall to rise (s)
(17) ON counts, OFF counts
This operation counts the number of times the signal has crossed the set
level upward or downward.
(18) ON time, OFF time, Operating Rate
This operation finds the time for which the signal remains above the set
level (ON time) and the time for which it remains below the set level (OFF
time).

3. Select the check box for a channel to be calculated.

4. Set each channel. Left-click any desired channel in the channel list to
display settings for that channel to the right.
Slope This parameter is used when calculating time for level, period,
frequency, pulse width, duty cycle, ON counts and OFF counts.
Filter, Level These parameters are used when calculating time for level,
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period, frequency, pulse width, duty cycle, ON counts, OFF counts, ON

time, and OFF time. Calculations are performed with respect to the specified

level. The signal is not assumed to have crossed the level until it remains
above or below the level as long as set for Filter.

Rise/fall This parameter is used when calculating the rise time and fall time.
If you set 20% here, the rise time is defined as a 20% to 80% rise time: the
fall time is defined as a 80% to 20% fall time.

. Click "OK" to reflect the new settings.
. Click the "Save" button to save calculation settings. Enter a name for the

calculation settings, then click "OK".

Save Calculation Settings x|

Calculation zettings name

Mew Settings,

Ok I Cancel |

. Click the Load button to load previously saved calculation settings. Select

the settings name you want to load, then click "Load" Click "Delete" to
delete the selected settings.

Load calculation settings x|
Hame

Load
Calc2 _—l

Calc4
Clac3 Cancel |

Delete |

3.8.2 Executing Calculations

Calculation
execute button

Calculation
setting button

Execute numerical operations on a selected range of waveform data as
follows:

. Set a range of waveform data in which you want to perform calculations.

ALL Entire range of waveform data

Selection Data in a section of waveform specified with interval-specifying
cursors

AB Cursor Data in a section of waveform specified with AB cursors.

2. Click the calculation execute button.

Parameter Calculation <Demo.mem:

& sl O Selecion ¢ AB Cursor |<Demo.mem> : -1 Bmiz(-1500) to 1.5ms(1500)

CH | avERaGE | RMS | PP | Mesirdie | Mas-TIME[Sec] =
ECHV] 000413023 | 034436216 | 099000000 | 048500000 | -0.0007S500
ECHZV] 0.00E555345 | 068552480 | 1.94500000 | 0.96500000 | -0.00075500
ECHAV] 000155615 | 103145653 | 292000000 | 1.45500000 -0.00075100

FECH4[M]: 0.00359713 | 1.37877534 | 3.31000000 | 1.35500000 0.00025200

B CHE[: 000204333 0 1.72497185 | 488000000 | 244500000 -0.00075700

W CHE[]: 087737 214154154 | 605500000 | 3.03500000 -0.0007&100
I’\_aiEHF"NI: 0.01743419 | 283865308 | 8.03000000 | 4.02500000 0.00025000 _ILI
4 k

3. Right-click in the calculation dialog box to display a popup menu.
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Copy selected range Copies the calculation results for a selected range of
waveform to the clipboard (from where they can be pasted onto "Notepad" or
other applications). Left-click to select a range. To select multiple ranges,
hold down the | Ctrl | or | Shift | key while left-clicking.

Copy all Copies all calculation results to the clipboard.

Floating-point display Shows the calculation results in floating-point format.
Exponential display Shows the calculation results in exponential format.
Auxiliary Unit display Shows the calculation results with auxiliary unit.

3.9 Manipulating the Waveform on Each Channel

This section explains how to manipulate the waveform in each section. Click
the "Display waveform operation window" button on the main toolbar to
display a waveform operation dialog box, or select "Waveform Control" from
the "View" menu to display the dialog box.

Drag the edge of the dialog box to resize.

3.9.1 Waveform Operations

You can magnify or compress the waveform on each channel and move the
zero position of the waveform. The zero position is defined to be 0% at the
bottom of the graph, 100% at the top of the graph, and 50% at the center of
the graph.

Left-click the desired channel to display the channel settings on the right.

. Changing the magnifying factor and zero position

You can select the option "Zoom/Position" to set a magnifying factor and
zero position. This also displays the upper and lower-limit values of the
graph.

Change magnifying factor Select from the magnifying factor select box.

Move position Enter a value in the zero position input box, then press the
key. You can also use the up/down buttons or slider to enter a value.
The colored range of the slider represents the upper and lower limits in the
window (0% to 100%).

'Waveform Control <Demo_mem> x|
Graph | Zoom | Range/DIV | Zero Position | Upper | Lower | - EHILY]
T % Zoom/Position " Waniable

I'valk2 . Zoom Upper
G1 w1 B0 25 -25 EE
G1 wl B0% | BOu | H0u 1 : ]
G1 w1 50% 250 -250 Position() Lawer
G1 «1 50 10 10 —

IED 3 5.5

G1 «1 50% | 25k 25k o
= = =2 e [ Thwert

FoCH 2y
.CHS[.L\]:Cunent
ECHAl[K]:Temp
FHCHE[Hz] Freqg
[ CHE[Y ] Mator
B CHP L Irrvarker

[ T e P

2.

Setting the upper and lower-limit values of the waveform window

When the option "Variable" is selected, you can set the lower-limit voltage
values of the waveform window. Clicking the Reset button sets the
magnifying factor and the zero position to x1 and 50%, respectively.
Upper-limit/Lower-limit values Enter a voltage in the upper-limit value or
lower-limit value input box, then press the key. The zero position
and unit/DIV are immediately changed.

Display range/DIV, Zero position Enter a voltage in the "Range/DIV" input box,
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then press the Enter key. Enter the zero position as a percentage in the
"Position" input box, then press the key. The upper-limit and lower-
limit values change immediately.

‘Waveform Control <Demo_mem3 x|
CH I Graphl Zooml Hangea’DNI Zern F'Dsitionl Llpperl Lowerl - _5H;W] Tl & Varisbl
= Lilaly} + \anable
ol | G1] -] (0.550000 il =
e
:Curren b 4 - — —
= — - o ey Jnssooon  =fs500000 =
CHE[HZ]:Freq G1 41 B0% 250 -2580 Pasttion(%) Lower
CHE[:Matar G1 41 B0% 10 -10 = =
R0.000000 = |-5.500000 = Fgset
ECH?N];Inveltel G1 w1 B0 25k 2.5k o I j I j —I
— - o . . o - == [ Inwert

3.9.2 Setting Others

Show/hide waveform——

Change waveform color

Waveform Control <Demo. mem?

| Graphl Zcu:rnl HangeﬁDI'\-’l ZEM0 F'cmitinnl Upperl anerl - _(E'HTZM o
= * Lialg]
S s el i
Fo]CH 2 i T olt2 G1 ul 25 25 Zoom
B CH AL Current Gl «1 25 25 _1
Fo]CHAK] Temp Gl #1 0w -Bu "
ﬁEHS[Hz]:Freq G1 1 250 250 Position[%]
CHER |k otor G1 w1 10 -10 <
IED 3
EEH?N];Inverter G1 w1 20k | 20k |
S e = mase = =2 [\ | Invert

\
Invert waveform

. Show/hiding waveforms

You can choose to show or hide the waveform for any channel by selecting
the check box for that channel in the channel list.

. Changing waveform colors

You can change the waveform color for any channel by clicking the icon for
that channel in the channel list.

. Drawing a waveform on top (analog waveforms only)

Point to any channel in the channel list and double-click the left mouse
button. The selected waveform is displayed on top of all other waveforms in
the waveform window. This facility should prove helpful when multiple
waveforms overlap and you have difficulty viewing a particular waveform.

. Copying channel setting

The same settings (magnifying factor, zero position, and variable) for a
channel are easily copied and set for other channels.

Specify source to copy Select the channel from which you want to copy and
click the right mouse button. Select "Copy CH Settings" from the ensuing
popup menu.

Reflect settings in other channels Select the channel to which you want
settings to be copied and click the right mouse button. Select "Paste CH
Settings" from the popup menu.

. Invert waveform (analog waveforms only)

Select the check box to invert the plus and minus sides of the waveform.

3.9 Manipulating the Waveform on Each Channel
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3.10 Setting Scaling and Channel Comments

This section explains how to set scaling and comments for each channel.
Select "CH Settings" from the "Settings" menu to display a "Channel
Settings" dialog box. Use the channel select tab in this dialog box to select
the channel for which you want to enter settings. After setting scaling and
comments for that channel, click the OK or Apply button to reflect your
settings.

* The scaling and channel comments are reflected in the waveform, logging,
and XY synthesis windows currently open for the same waveform file.

|La-8] e 1D
| Scaling | EUA [ VoltP1 [ ScaePl [ Comment
[ Unt | Difset [ wvoltP2 | ScaleP2
CH1 |HAT|D =l|+11000E+0 = R [FE0000E-03 = [FES000ECE = [Volt!
| v|[+0.0000E+0 =/ P2 [E0000E0S =] [S5000E-05 = Lsetl
CHZ |HAT|D Z“+5_0000£+n 3 Fq |+5|j||j||]|]Er|]E: |+: SO00E-02 = |VOIt2
| miv | [+0.0000E+0 =) P2 [S0000E 02 |-25000e02 = Lse'l

cH3 [RaTio [x|[+5.0000e+0 =/ 1 [E0000E 0
| A/ [+0.0000E+0 = P2 [S 000002

[+25000E-02 =] [Curent
[25000E-02 = | reset |
|+5.0000E-08 =/ [Temp
[SotEne =] reset |
CHE  [POINT [ ] [+E0000E = P1 [+1.0000E+00 = [+5.00008+01 =/ [Freq

| He [FO0000E+0 =] | P2 [+0.0000E+00 =] [+0.0000E+00 = | reset |
CHE [ronT [=][+2 000050 = P1 [+1.0000E+00 = [+20000€+00 =/ [Motor

| v [FO0000E 0 =] P2 [1.o000E+00 | [20000E+00 = | reset |
CH7 [POINT [=|[+50000E+2 = P1[+200006-01 = [+1.0000£+02 = [Inverter

| v [FoomioE - = P2 [+00000E+00 =| [+00000E+00 = | reset |
CHe  [PONT [w ][+ 000080 = P [e00000E+00 = [+1.0000€+00 =/ [Fower

| w [FT0000Es0 =] P2 [+1.o000e+00 = [+50000E+00 = | reset |
0K I Cancel Apply

CH4  [RaTio [=][+1.0000E6 = F1 [+50000E-05
| K [+0.0000E+0 = P2 S0000E05

bl ]l bl ]

3.10.1 Setting Scaling

The scaling function lets you convert voltages into a physical quantity to be
measured. The gauge divisions and cursor readouts display scaled values.

1. Set by conversion ratio
Set the physical quantity per V (EU/V), an offset, and a unit name so that
voltage values are converted into the corresponding value in units you have
set. After selecting "Ratio" for the scaling method, enter your desired
conversion ratio, offset, and unit name.

2. Set by two points
Set the voltage values at two points and set the conversion values and unit
names for the respective points before performing conversion. After selecting
"Point" for the scaling method, enter the pre-conversion voltage values at
two points and the post-conversion values and unit names for the respective
points.

3.10 Setting Scaling and Channel Comments
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3.10.2 Setting Channel Comments

Channel comments set with the MEMORY HiCORDER can be edited.
Comments are displayed in the waveform window, detail print, and various
settings windows. Enter a character string in the "Comment" input box
provided for each channel.

3.11 Using Tools

Any application can be registered to the tool button, and once registered can
be launched simply by clicking the button.

3.11.1 Registering Applications

You can register up to five applications to the tool button.

Select "Set Tools" from the "Tools" menu, and the "Set Tools" dialog box is
displayed. Or click the arrow to the right of the tool button on the toolbar
and select "Set Tools" from the resulting menu.

After setting up the tool, click OK.

Set Tools x|

Tooll | Tool2 | Tool2 | Toolé | Taks |

Mame

|
Carmrmand line I Erowse |
Parameter I
Folder I BRefer |
0K I Cancel |
. Name

Enter the name of the application.

. Command line

Enter the execution file of the application.

. Parameter

Enter the parameter or file name which is to follow the execution command.

. Folder

Enter the runtime directory of the application.

3.11.2 Executing the Tool

Before you can execute the tool, you must have at least one application
registered to it.

Select the "Tools" menu or click the arrow to the right of the tool button on
the toolbar. The registered applications are listed on the menu. Select an
application, or click the tool button to invoke the previously used
application.

3.11 Using Tools
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3.12 Saving Waveform Data over Existing Data

Title comments, channel comments, and scaling can be saved over the
existing data.

Select "Save Waveform File" from the "File" menu to save these settings over
the existing file.

* Because the previous settings are deleted when saved over the existing file,
be sure to produce a backup of the file beforehand.

3.13 Numeric Display of Waveform Data

The loaded waveform data can be displayed numerically. The data for analog
channels are represented by voltage values (if scaling is turned on, by scaled
voltage values), the data for pulse channels are represented by integration or
revolution values (if scaling is turned on, by scaled values), while the data
for logic channels is represented by binary 0 and 1.

Select "Logging Window" from the "View" menu, or click the "Display
logging window" button on the toolbar. A logging window is displayed.
Multiple logging windows can be displayed by repeating this procedure.

[55] Logging Screen <Demo.mem: 2> O] x|
| %[ -] *e *g by Y

Date | CHIN}oT | CHZ[miv] Vo2 | CH3[ALCument| CHAKETemp| CHS[HzkFreq| CHE[EMotar| =]

k01942001 957-6.8185 -B0.5m -475m 550m -1.55u 85 Hm| o
10,41 9/2001 9:57:6. 616501 -Bkm 500 -500m 1.7u 9,25 -440m
10/19/2001 9.:57:8.818502 -Bm 525m -B50m 1.6u 10 -430m
10,41 9/2001 9:57:8.618503 -71.5m 55 700 1.95u 10.75 -510m
10/19/2001 9:57:8.818504 -71.5m 575m -750m -2.05u 1175 -550m
10/19/2001 9:57:8.818505 77m -£25m -B00m -215u 12,25 -530m
10419/2001 9:57:8.818506 77m -£25m -850m -2.3u 13.25 -630m
10/19/2001 9:57:8.818507 -B8m -£75m -875m 245y 13.75 -670m
10419/2001 9:57:8.818508 -88m -700m -925m -2.45u 14.75 -710m
10/19/2001 9:57:8.618509 -93.5m -725m -975m -26u 15.25 -740m

Al 10/19/2001 957881851 -93.5m -750m 1 -2.75u 16 -780m
10/19/2001 9:57:8.616511 -93.5m -B00m -1.05 -2.85u 165 -810m
10,19/2001 9:57:6.818512 -99m -625m 1125 -3u 75 -850m
10/19/2001 9:57:8.819513 -104.5m -B50m 1175 31 18.25 -830m
10,19/2001 9:57:6.618514 -104.5m -900m 1175 -3.25u 19 -320m
10/19/2001 9.57:8. 818515 -104.5m -500m 1.25 -3.35u 19.75 -960m
10,19/2001 9:57:6.818516 110m -525m 1.275 -3.45u -20.25 1
10/19/2001 9.57:8.818517 1155m -350m 1.3 -3.6u .25 .03
10,19/2001 9:57:6.818518 1155m 1 1.375 3.7u -22 -1.08
10/19/2001 9:57:6.818519 121m 1.025 1.4 -3.85u 2275 RN

Bl 101942001 957651652 1265m .05 -1.45 -3.9u 235 115
10/19/2001 9:57:8.616521 132m 1. 1.475 -4.05u 24.25 1.8
10,41 9/2001 9:57:8. 618522 132m 44 .55 420 -25 1.2
10/19/2001 9:57:8.818523 126.5m 115 16 -4.3u 255 1.25
10,19/2001 9:57:8.618524 132m 1.2 1.625 4.4y 365 1.3
10419/2001 9:57:8.818525 143m 1.225 1.675 -4.55u 2705 1.33
10/19/2001 9:57:8.819526 143m 1.225 1.7 47u -28 1.3
10/19/2001 9:57.8.818527 1485m 125 1,75 -4.8u -28.75 14| B

4] | _’|_I

Logging window__[=/@8s5 [£: MEM [ 100us (us] |5 3001V - 3rs(3001) | 1) 07-10-18 08:57:08 82 |- 7» 60 2 [[5] Waveform Screen <Demomemds

status bar |

Title of the reference waveform window

If a logging window is displayed while the waveform window is active, the
logging window will contain the active waveform window cursors. The
logging window status bar shows the title name of the waveform window
being referenced. If a display range was set for the waveform window, that
range of waveform is logging-displayed. (See 3.2.6.)

3.13 Numeric Display of Waveform Data
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For recorder function, realtime function (envelope on) or rms value function
waveform data, the logging window has tabs labeled "MAX/MIN" and
"Average" at the bottom of the window. If you select the "MAX/MIN" tab,
both the maximum and minimum values are displayed. If you select
"Average" the average of the maximum and minimum values is displayed.

* Logging display may not be produced, depending on the operating
environment of your computer. In this case, narrow the display range of the
waveform window before reattempting logging display. (See 3.2.6.)

3.13.1 Logging Window Menus

[File] —— 1 [Open Waveform File]
——[Convert All]

——[Convert Between Cursors]
——[Batch Conversion]

——[Save Waveform File]
—[Logging Print] (See 6.3)
—[Logging Print Preview] (See 6.3)
— [Logging Print Settings] (See 6.3)
—[Printer Settings]

— [Exit]

[Edit]

[View] ——[Waveform View]
—[Logging View]
——[XY View]
——[Waveform Info]
——[Toolbar]

——[Status Bar]

[Settings] [CH Settings]

[Tools] [Set Tools]

[Window] [New Window]
[Cascades]
[Tile]

[Arrange Icons]
[Close]

[Close All]

[Help] [About 9335 Wave Processor]

f

—|:[Main Toolbar]
[Logging Toolbar]

T[Main Status Bar]
[Logging Status Bar]

Equivalent to functions on the waveform window
menu

Equivalent to functions on the waveform window
menu

[Copy] : Copies a selected range of numeric values to the clipboard. (See 3.13.3.)

Equivalent to functions on the
waveform window menus

3.13 Numeric Display of Waveform Data
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3.13.2 Logging Window Toolbar
J?Hm%—;nw tatatas

1. Channel display setting button
Selects the channel to be displayed. Click this button to display the dialog
box, select the check box for the channel you want to display, and click OK.

Select CH x|

WwICH1  LB1
wCHZ [ILEZ2
Ww]CH2 [wILEZ
w]CH4 [ILE4
wICHS  WLCT
w]CHE [ILCZ2
WwCH?  [LC3
w]CH2 [ILC4
WwiLa1 LD
wiLae  WILD2
WwiLa2  WILD3
wiLad  WILDd

Cancel |

2. Thin out
Sets a time interval at which intervals the numeric values are displayed.

3. Cursor search
If any referenced waveform window is referenced, you can quickly scroll
through the numeric display window until you reach the cursor A or B
positions, the interval cursor, or the search position. Click the button for the
marker for which you want to search.

3.13.3 Other Operations

Right-click in the logging window to display a popup menu.

Copy Copies a selected range of data in the logging window to the
clipboard, from where it can be pasted into "Notepad" or other applications.
To select multiple lines, hold down the | Ctrl | or | Shift | key while left-
clicking.

Show Waveform Shows or hides analog, pulse and logic waveforms
simultaneously.

Time Notation Changes the display method for the time shown at the leftmost
position of the window. Select from "Date", "Trigger Time", "Second", or
"Data Number".

Logging Sets a time interval at which intervals the numeric values are
displayed.

Numeric Format Changes the display method for voltage values. Select from
"Exponential", "Floating-point", or "Auxiliary unit".

Move Cursor When a reference waveform window is specified, you can move
cursors to any position in the specified waveform window. Start trigger, stop
trigger, cursor A, cursor B, section start cursor, section end cursor or search
position can be moved to a selected position in the numeric display window.

3.13 Numeric Display of Waveform Data
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3.14 Waveform Window Hard Copy

When waveform windows are saved to a file or copied to the clipboard, you
can paste waveform images into a word processor or other applications.

3.14.1 Setting Hard Copy

Set the method for producing a screen hard copy. If you select "Capture
Settings" from the "Edit" menu, the "Capture Settings" dialog box is
displayed.

Capture Settings

r— Dlutput
" Save toFile

— Format

T WWindows Meta " Bitmap

Color ICDInr 'I
ar. I Cancel |

1. Set output destination
Transfer to clipboard Copies waveform images to the clipboard.
Save to file Saves waveform images to a file (always in extended meta
format).

2. Output format
Extended meta format With this format, even if you resize the image pasted
into another application, the image will not change shape significantly. If
you select this format, be sure to set an output color at the same time.
Bitmap format Images are copied in bitmap format.

3.14.2 Executing Hard Copy

Select "Capture Waveform Screen" from the "Edit" menu to execute hard
copy. If you selected "Save to file" for the output destination, the destination
setting dialog box is displayed. Enter a file name and click "Save".

3.14 Waveform Window Hard Copy
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Chapter 4
Text Conversion

|
Once waveform data is converted into text, you can use it in spreadsheet
software such as Excel®.

* Converting waveform data into text produces a file that is significantly larger
than the original file size. Make sure that the hard disk has sufficient space.

4.1 Converting All

The whole of the currently displayed waveform data is converted into text.
Select "Convert All" from the "File" menu or click the convert all button on
the toolbar to display the "Convert All" dialog box. Click Save after entering
required data into the dialog box.

Convert all 2] x|
Saven: | {2 DaTA =] « @& ek @ Analog | Logic |5
&) Demal.csv [VICH1
@ Demol.cav CH2
@ Demo3.cav CH3
CH4
CHS
CHE
CH?
CHa
1 . File name: IDemo
2 Save az tupe: ICSV[Eomma separated) j Cancel |
| 6.
3 ThinClut: |1 ::II |Sa\.-'ed data num. : 3001 ™ Dpen after conversion
4 Time Matation: ISecond 'I

1. Post-conversion file name

2. File format in which to save
Select from CSV (comma separated), text (space separated), text (tab
separated), COMTRADE(1991) or NMEA 0183(GPS data). CSV format files can
be loaded in Excel®.

3. Interleaved data counts
Set the number of interleaved data.

4. Time-axis format
Select from Second, Date, Trigger time, or Point.

5. Select the channels to convert
Select the channels you want to convert. The greater the number of channels
converted, the larger the resulting file size.

6. Open after conversion

Leave this check box checked to have the resulting file opened in the
application associated with it following text conversion.

4.1 Converting All
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4.2 Converting Partially

A section of the currently displayed waveform which is enclosed by section-
specifying cursors is converted into text.

Select "Convert Between Cursors" from the "File" menu or click the Convert
Between Cursors button on the toolbar to display the convert partially dialog
box. Fill out this dialog box in the same way as for converting the entire
waveform, then click Save.

If you specify "Binary" for file type, you can save a section of waveform
data enclosed by section-specifying cursors instead of converting the
waveform data into text.

By selecting and saving only a necessary part from a large waveform data
file, you can significantly reduce display time and processing time when

later analzzing that Bart of the waveform.
4.3 Converting Collectively

Multiple files can be converted into text collectively.

Select "Batch conversion" from the "File" menu or click the convert
collectively button on the toolbar to display the "Batch conversion" dialog
box. After filling out this dialog box, click Convert... button.

* The settings for each waveform file (files with the extension ".hps" (see 3.1)) are not
loaded.

Batch conversion 7] %]
Lock in: [ '3 DATA =l = ®@ cF E-

2 . File name: I"sampleE.mem” "sample2. mem" “sample1. mem' Corrrert... I
3 . Files of type: IWavefDrm filesl.mem; .iec: .ims paw) j Cancel
4 Thin Out lq
5 ) Dutput Folder IE.\9335\MEmH\D atatDATA Browse
6 Output Format ICSV[COmma separated] j
7. Time Motation |5econd -
1. File list

Select the source file you want to convert. Hold down the | Ctrl | or | Shift |
key while left-clicking to select multiple files.
2. File name
The selected files are displayed.
3. File type
The file format of the files is displayed in the file list.
4. Interleaving counts

5. Output destination folder
Converted files are stored in this folder. The file names in this folder are
inherited from the source files.

6. Save format
Select from CSV (comma separated), text (space separated), text (tab
separated), COMTRADE(1991) or NMEA 0183(GPS data). CSV format files can
be loaded into Excel®.

7. Time-axis format
Select from Second, Date, Trigger time, or Point.

4.3 Converting Collectively
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Chapter 5
X-Y Synthesis Window

The waveform data can be X-Y synthesized before being displayed on the
screen. Up to 16 waveforms can be X-Y synthesized by assigning analog or
pulse channels to the X and Y axes. "MEM", "REC" (envelope off), "POW",
or "XYC" waveforms can be X-Y synthesized.

* Numerical operations cannot be performed in the X-Y synthesis window.

* Support provided only for searches by date/time. For more information on the
search method, refer to 3.7.1. Note also that trace cursor A is displayed at
the search position.

5.1 Displaying the X-Y Synthesis Window

1. Load waveform data to display a waveform window beforehand. Using
section cursors, set a range of waveform you want to be X-Y synthesized.

2. Click the X-Y synthesize button on the waveform toolbar, or select "XY View"
from the "View" menu. The range of waveform enclosed by interval cursors
is X-Y synthesized. Display multiple instances of the X-Y synthesis by
repeating this procedure.

E]XY Screen <SampleWaveXY mem: 2> 10O %]

BxXyl X:(CHDI
YACH2I
Exy2  X«CHLI
YACHII
BEXY3 X:(CHDI
Y:(CH
BxXy4 X:(CHDI
YACH2I
HXVs  X«CHLI
YACH2I
EXYs X:(CHDI
Y:(CHHI
X:(CHIM
YACH2I
HXvE X«CHLI
Y:CH2M
EXy®s X:CHDI
Y CH2M
EXY1e X:(CHDI
YACHI
HEXV1l X«CHI
Y:CH2M
EXY12 X:(CHDI
Y CH2M
EXY13 X:(CHDI
Y CHI

CH2 (100mYy/DIV)
CH3 (100mYy/DIv)
:

-1 CHI (100miv/DIv) +1
[v]

[22( 5855 [£o: MEM [ ¢ 200us (2us] | T 020117 09:34:22.64 £z -20ms to 20ms | 4

5.1 Displaying the X-Y Synthesis Window
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Stopping waveform drawing

For large waveform data files, the system requires more time to redraw the
waveform. To abort waveform drawing, press the key on the keyboard.
Click the "Update" button on the toolbar to let the system redraw the
waveform window.

5.2 Manipulating the X-Y Synthesis Window

The main toolbar works the same way as in the waveform window. For more
information, refer to the description of the waveform window in the earlier
section of this manual.

5.2.1 X-Y Window Menus

[File] ———[Open Waveform File]
——[Convert All]
——[Batch Conversion]

——[Save Waveform File]
——[Screen Print] —————[Print]
—[Preview]

[Page Settings] Equivalent to the function on the

waveform window menu

——[Waveform ————[Print]

Detail Print] [Preview]

——[Page Settings]

——[Printer Settings]

—[Exit]
[Edit] —|:[Capture XY Screen] : Produces screen hard copy. (See 5.5.2.)
[Capture Settings] : Sets a screen hard copy.
[View] —— 1 [Waveform View]
—[Logging View] Equivalent to the function on the
XY View] waveform window menu

——[Waveform Control] : Displays the Waveform Operations dialog box.  (See 5.5.1.)
——[Waveform Info]

——[XY Cursor] : Displays the XY Cursor dialog box. (See 5.3.1))
—[Search] : Displays the Search dialog box.

——[Toolbar] [Main Toolbar]
L[XY Toolbar] ] )
——[Status Bar] —I:[Main Status Bar] \Iigl\jg’faolﬁﬂt\:/?nghoewﬂﬁgﬂﬁn on the
[XY Status Bar]
[Settings] ——[Graph Settings] : Sets XY graph display. (See 5.2.4.)
—— [CH Settings]
—— [Compose Range Settings] : Sets a range of data to be XY synthesized. (See 5.2.5.)
—— [Templaate] : Save or load a template file.
[Tools] ——  [Set Tools]
[Window] [New Window]
[Cascade] ) )
[Tile] > Equivalent tq the function on the
waveform window menu
[Arrange Icons]
[Close]
[Close All]
[Help] ———[About 9335 Wave Processor]

5.2 Manipulating the X-Y Synthesis Window
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5.2.2 X-Y Waveform Toolbar

e A L il A el A B IG]
1.2.3 4 5. 6.

~N—LY

1. Cursor A operation mode
Left-click anywhere in the waveform display area when this button is
enabled to move vertical cursor A to that position. Hold down the key
and left-click to reposition the horizontal cursor A.

2. Cursor B operation mode
Left-click anywhere in the waveform display area when this button is
enabled to move vertical cursor B to that position. Hold down the key
and left-click to reposition horizontal cursor B.

3. Comment operation mode
When this button is enabled, you can enter or edit comments. Enter
comments in the same way as in the waveform window.

4. Cursor mode selection
Selects among cursor OFF, the trace cursor, and he voltage cursor.

5. Cursor display
Shows the vertical and horizontal cursors A and B.

6. Graph settings
Sets an XY synthesis window.

7. Update
Updates the waveform window.

5.2.3 Popup Menu

Right-click anywhere in the X-Y synthesis window to display a popup menu.

[E] XY Screen <5ampleWaveXY. mem: 2> M =]E3
[N R e BES
3_ Sample Waveform |

2 Al 5.
6_ EAXY3 X:CHDI

+1 __
[v] |

BxXYl X:(CHDI
[v] Y:(CHII
X¥2  X:(CHDI

YACHI

I
X +1
I
d I
v
X I
4 V:(CHAI

it ORI / EXv4  XCHDI

Y:(CHM
HXVs X«(CHDI
YACHM
HXVe X:(CHHI
Y:ACHN
X:ACHDI

m’h

Y:(CHM
FEXYE X«CHDI
Y(CHM
k EXve X:(CHDI
'y i Y:CHM
’ ,."I FEXY10 X«CHD
Y:(CHM

i . :
- L e &

| ; EIXY1l X:(CHII
1 i Y i VA CHI
l . N4 BIXYI2 X:(CHDI

! YACHDI
] ! L

1

I

CH2 (100mY/DIV)
CH3 (100mY/DIV)
-

EXV13 X:(CHDI
Y:CHOI

v u T s e e e e e o e |
=1l CHT (100m%/0) +1
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[22/ 8855 Lo MEM [ 200us (Zus] | T) 020117 09:34:22 54 [f.: 20ms to 20ms | 4

5.2 Manipulating the X-Y Synthesis Window
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1. Gauge display
Works the same way as in the waveform window. The vertical and
horizontal axes can be set independently.
Gauge Type - Dual The gauge is displayed on both sides of the waveform
window.

2. Marker display
Cursor A, Cursor B Shows or hides the respective markers.

3. Title
Same as the title of the waveform window.

4. Inside the X-Y window
Show Waveform Shows or hides several waveforms at once.
Screen Format Up to 16 (4 x 4) graphs can be displayed.
Grid Shows or hides horizontal, horizontal auxiliary, vertical, and vertical
auxiliary lines.
Color Sets the waveform background, grid line, and auxiliary line colors.
5. Periphery of the waveform window
Synthesis Range Resets the range of waveform data to be X-Y synthesized.
Set the start and end points in the opened "XY synthesis Range Settings"
dialog box and click OK.
Show Shows or hides each display area.
Template Save or load a template file.
Capture Copies the XY screen to the clipboard or saves it to a file, from
where it can then be pasted into other applications.
Toolbar, Status bar ~ Shows or hides each display.

6. Waveform legend display
Channel Changes channel information display.
Show Waveform Shows or hides several waveforms at once.
Resize Changes the size (width) the waveform legend display area. The
display area is enclosed by dotted lines. Drag the left or right square at the
center of the display area to resize to the desired size.
Text Color, Font Sets the character color and font for the waveform legend.

5.2 Manipulating the X-Y Synthesis Window
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5.2.4 Setting XY Graphs

Set how XY graphs are displayed.
Click the "Set graph" button on the XY window toolbar or select "Set
Graph" from the "Settings" menu to display the "Set XY Graph" dialog box.

XY Graph Settings
— Graph Murm Gauge 6
Iﬂ 5 Tupe Murm 1 o ILI
4>< X-axis IMuItipIe 'l |4 _|::[ 7 2 . Cancel |

-amiz IMuItipIe 'l |4 :: ¥ Dual 3 &pply |
o | e P L 4 o 6!

CH 1 0 . Gauge EH1 2 Gauge Style Graph width

Shaow

o =] ¥ || Jone =] P (e =[ar =] =]
[cir =] || fovz =] B0 fuee  =fsz =1 =]
o =] # || Jone =] M| Jire  =l[as =] =]
Tz ]| ot = || oz = F0 e =l [es =] =]
Cnz w]| ot =] F || oz = F | uee =le =] =]
Cxrtd ml| oot =] M| Jovz =] B e =[5z =1 =]
Ciwets L] [ocit =] 0| Joiz =] W0 | June =] [63 jm
Ciwete L[| [ocit =] 0| Joiz =] W0 | June =] [Gs jm

8% xn Jg [orn =] M || [0z =] B e =l J6r = =]
Moz || o =] # | Jons B M| i 2lse =1 E]
Fowa | o =] | Jois 5] B o 7l ez 2|1 E]
Foed || o 2] | Jovz 5] | e 7l fes 2] fe =]
s ml| o =] | Joe 5] ot e =] E]
e m|| [ciz =] M| Jois 5] B [Maken 7] [52 <1 5]
ot ]| ot =R ez = R Makez =] ez =] 1]
Covg ]| ot = || oz = F0 | oee =l fes =] =]

=]
=]
=]

1. OK button
The new settings are reflected in the graph. The dialog box is closed.
2. Cancel button
The new settings are canceled (i.e., not reflected in the graph). The dialog
box is closed.
3. Apply button
The new settings are reflected in the graph, but the dialog box is not closed.
4. Select graph divisions
A graph can be divided into as many as 16 regions (4 x 4).

* Depending on the window size, not all graph subdivisions may be displayed.
5. Select gauge type
Select the types of X and Y-axis voltage gauges from "None",
"Upper/Lower", "Detail", or "Multiple" respectively.
None No gauges are displayed.
Upper/Lower For channels that have gauge display turned on, the gauge for
the channel with the smallest number is displayed. Voltage values are
displayed at both ends of the gauge.
Detail For channels that have gauge display turned on, the gauge for the
channel with the smallest number is displayed. Voltage values are displayed
at every five divisions.
Multi For channels that have gauge display turned on, gauges are displayed
for as many channels as specified by gauge counts, beginning with the
channel with the smallest number. Voltage values are displayed at both ends
of the gauge.

5.2 Manipulating the X-Y Synthesis Window
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6. Gauge counts
For multiple gauge types, set the number of gauges you want to display. For
channels that have gauge display turned on, gauges are displayed for
channels sequentially, beginning with the channel with the smallest number.
7. Gauge dual
Gauges are displayed on both sides of the graph. This item can only be set
for the Y-axis gauge.
8. Show/hide XY
Select the check box for any XY waveform to display the selected XY
waveform.
9. Waveform color setting button
Set colors for each XY waveform.
10. Select X-axis channel
Select X-axis channels.
11. Show/hide X-axis gauge
Select the check box for any channel, and the X-axis voltage gauge on that
channel is displayed. The number of gauges displayed is limited by the
gauge type and gauge counts set.
12. Select Y-axis channel
Select Y-axis channels.
13. Show/hide Y-axis gauge
Select the check box for any channel to display the Y-axis voltage gauge on
that channel. The number of gauges displayed is limited by gauge type and
gauge counts set.
14. Select interpolation method
Set the method by which the graph is interpolated. Select "Dot", "line", or
"Marker 1-8".
15. Select display graph
When the graph is divided, select the graph that shows the waveform you
want.
16. Select line width
Select the line width of the waveform.

5.2.5 Setting the XY Synthesis Range

The range of waveform data to be XY synthesized can be set.

Select "Synthesis Range Settings" from the "Settings" menu or double-click
in the "XY synthesis area" on the XY window status bar to display the "XY
Synthesis Range settings" dialog box.

X Synthesiz Range Settings x|

g} |Se|ec:ti0n range : -300us [-300) to 2. Fms [2700)

)
Start LI '300::|| | -300us

End 3} 27002 |27ms

()8 I Cancel

1. Show synthesizable range

5.2 Manipulating the X-Y Synthesis Window
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2. Set start point
Set the first point of the waveform data you want to synthesize. A relative
time for that point (time from the trigger) is displayed to the right.

3. Set end point
Set the last point of the waveform data you want to synthesize. A relative
time for that point is displayed to the right.

4. OK button
The new settings are reflected in the graph. The dialog box is closed.

5. Cancel button
The new settings are canceled (i.e., not reflected in the graph). The dialog
box is closed.

5.3 Cursor Function

The cursor function lets you read the voltage values at specified points. Both
trace cursors and voltage cursors are available.

5.3.1 Trace Cursors

Shows the point at which the cursor and waveform intersect.
How to use

1. Click the cursor mode select button on the XY waveform toolbar to select
trace cursor mode.

2. Click the cursor display button on the XY waveform toolbar to display the
desired cursors.

3. Display the XY Cursor dialog box to read voltage values. Click the XY
cursor button on the main toolbar, or select "XY Cursor" from the "View"
menu.

XY Cursor dialog box

XY Cursor <5ampleW aveXY mem> x|
A cursor 3 B curzor 3 B-& 4

Tirne 1 -16.956ms =1 1 -20ms ﬂ 2 -3.044ms = |

-

B [eeElb:

#-anis -454.4375m - | 6 1.9375m | 7 456.375m |
6. . =l

r

- - -

|>¢r1j81cH11 vz =] T

¥-awis 307.75m 0| -351.9375m =] 7 -659.6875m |

- . e . -

[ js'[I:H2] [revz =] 13y

XY Cursor dialog box

1. Time value display area
2. Time difference display area

3. Button for moving cursor
Click the up or down button to move through the data points in sequence.

5.3 Cursor Function
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4. Button for moving cursors A and B simultaneously
Click the up or down button to move through the data points in sequence.
5. Select graph
Select the graphs to be referenced by cursors A and B, respectively.
6. Voltage value display area
. Voltage difference display area
8. Reference channel

~

5.3.2 Voltage Cursors

Voltage values on X and Y axes can be read.
How to use

1. Click the cursor mode select button on the XY waveform toolbar to select
voltage cursor mode.

2. Click the cursor display button on the XY waveform toolbar to display the
desired cursors.

3. To move the cursor, drag the cursor marker or the cursor in the waveform
window (hold down the left mouse button while moving the cursor). Or left-
click "Cursor A operation mode" or "Cursor B operation mode" button on the
waveform toolbar and click at any position in the waveform window.

4. Display the XY Cursor dialog box to read voltage values. Click the XY
cursor button on the main toolbar, or select "XY Cursor" Window from the
"View" menu.
XY Cursor dialog box

XY Cursor <5ampleWaveXY _mem> x|
A curzor B cursor B-a

Tlime N = =

= = =
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(¢¥]
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B B
wa v| [CH1] Bv2 =] TCHT]
2 A
¥-amis 111m =] 3m~] -422m [~
= = -
5. [xv3 =] " fcHa1 Sf<rs x| [EH2)

XY Cursor dialog box

]

w

1. Voltage value display area
2. Voltage difference display area

3. Button for moving cursor
The cursor moves in vertically or horizontally.

4. Button for moving cursors A and B simultaneously
The cursors move at the same time.

5. Select graph
Select the graphs to be referenced by cursors A and B, respectively.
6. Reference channel

5.3 Cursor Function
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5.3.3 Popup Menu

Right-click in the XY Cursor dialog box to display a popup menu.

Copy cursor value Copies the cursor values in the dialog box to the
clipboard, from where they can be pasted into "Notepad" or other
applications.

Time display Changes the display method for the time shown in the time
display area. Select from "Date", "Trigger time", "Second", or "Data Number".
Exponential, Floating-point, Auxiliary unit Changes the display format for voltage
values.

Show unit Shows or hides the unit of measure in which units the voltage
values are displayed.

5.4 Waveform Information Dialog Box

The waveform information dialog box shows information on settings of each
channel.

Click the "Display waveform information window" button on the main toolbar
to bring up this dialog box, or select "Waveform Info" from the "View" menu.

The method of operation in this dialog box is the same as for the waveform
window. (See 3.6.)

5.5 Manipulating XY Graphs

5.5.1 Waveform Operations

You can choose to show or hide each XY graph, as well as set the waveform
color, magnifying factor, and zero position.

Click the "Display waveform operation window" on the main toolbar or select
"Waveform Control" from the "View" menu to display a "Waveform Control"

dialog box.
Change colors
Waveform Coatrol <5ampleW aveXly mem> x|
w1 Moy | Eraphl I:Hl Zc-c-ml Hange.f’DI\-"l Zero Pn&itionl Upperl Lowerl - _(C"sz e -
Show — ! BTSRRI TR S I RN Ml || © Zonroson Ve
/hide STTY 8I5] CH 2[] %1 50% 1 1 s s
El<rapeasis] . G1 ) CH 1M wl RO 1 4 5 | ; |_
20 Axl5] CH 3] 41 50% 1 -1 I:ﬂ [ ]
[ 3 1S G1  CH] w1 50% 1 -1 Position(3)] Lower
Ser A 415 CH 4[] wl RO 1 4 = | 7
Elovapaxs] Gl CHV] wl B0 1 4
SCPALY 5] CH 2[] u1 50% 1 A =] L] Tnvert

1. Show/hide XY graph
Select the check box for any desired XY graph.
2. Change waveform color
Left-click any desired XY graph icon to change waveform color.

5.5 Manipulating XY Graphs
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3. Change magnifying factor and zero position
Select the XY waveform you want to work on from the XY graph list (select
X and Y axes). The channel information assigned to the axes of the selected
XY graph is shown to the right of the list. The procedure is the same as for
the waveform window; refer to Section 3.9.1, "Waveform Operations".

* If multiple XY waveforms have the same channel assigned, operations
performed on one such XY waveforms is reflected in all other such XY
waveforms.

5.5.2 XY Window Hard Copy

If XY windows are saved to a file or copied to the clipboard, you can paste
waveform images into a word processor or other applications. The procedure
used here is the same as for the waveform window; refer to Section 3.14,
"Waveform Window Hard Copy".

* If a large waveform data file is XY synthesized, waveform images may not
be pasted in extended meta format into application software.

5.5.3 Setting Scaling and Channel Comments

You can set scaling and comments for each channel. Select "CH Settings"
from the "Settings" menu to display the "Channel Settings" dialog box. Use
the channel select tab in this dialog box to select the channel for which you
want to make settings. After setting scaling and comments for that channel,
click the OK or Apply button to enter your settings. The procedure used here
is the same as for the waveform window; refer to Section 3.10, "Setting
Scaling and Channel Comments".

* The scaling and channel comments are reflected in all waveform, logging,
and XY synthesis windows open for the same waveform file.

5.5 Manipulating XY Graphs



51
.

Chapter 6
Printing

You can print the loaded waveforms, using screen print or detail print
functions.

6.1 Screen Print

Prints waveform screen and X-Y synthesis screen hardcopies.

6.1.1 Printing

While the window for the waveform file you want to print is active, select
"Screen Print" - "Print" from the "File" menu. The print dialog box is
displayed. After setting up the printer and print range, click OK. The system
begins printing the selected screen.

* Depending on the printer being used, XY screens synthesized from large
waveform data files may not be printed.

6.1.2 Print Preview

Select "Screen Print" - "Preview" from the "File" menu to preview print
results.

6.1.3 Setting Screen Print

Select "Screen Print" - "Page Settings" from the "File" menu to display the
"Screen Print Settings" dialog box. After setting up the printing method,
click OK.

Screen Print Settings
—Paper

Size: ILeller j

Sovrce: IAuto sheet feader j
— Orientation Marging [millimeters)

&' Portrait Left: |2D Bight: |2D

" Landscape Top |2U Bottom: |2U

—Dutput—————————— Poszition _
(0] 4

& Color " Centered

' Gray Cancel |

" Black and White

Frirtter... |

6.1 Screen Print
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6.2 Detail Print

Waveforms are printed in detail.

6.2.1 Printing

While the window for the waveform file you want to print is active, select
"Waveform Detail Print" - "Print" from the "File" menu. The print dialog box
is displayed. After setting up the printer and print range, click Print. The
system prints the selected screen according to the current detail print
settings. To save the print image in a file, click Meta files button.

* Depending on the printer used, XY screens synthesized from large waveform
data files may not be printed.

6.2.2 Detail Print Preview

Select "Waveform Detail Print" - "Preview" from the "File" menu to view a
print preview displayed according to the current detail print settings.

6.2.3 Setting Detail Print

Select "Waveform Detail Print" - "Page Settings" from the "File" menu to
display the "Waveform Detail Print Settings" dialog box. Settings made in this
dialog box apply to detail prints of all waveform files.

Each item in the Set Detail Print dialog box is explained below.
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1. Print format
Set the format of detail print.
The formats "1 Graph" through "16 Graphs" correspond to 1-screen through
16-screen settings made when printing to the MEMORY HiCORDER's built-in
printer. The graph is divided into 1 to 16 smaller sections, and the channels set
in each of such graphs are printed. (the channel to which the graph belongs
depends on how the graph was set on the screen when divided.) In the formats
"2 rows" through "16 rows", the graph is printed on a specified number of
lines wrapping around at the end of each line. The range of waveforms (in the
time-axis direction) that can be printed in one page can be extended. But the
greater the number of rows, the smaller the number of logic waveforms
printed. (Waveforms with small position numbers have priority.)
The formats "XY1" through "XY4" correspond to the XY1 screen through XY4
screen settings entered when printing to the MEMORY HiCORDER's built-in
printer. The synthesis waveforms set in each of graphs one to four are printed.
(The correspondence of synthesis waveforms to graphs depends on how the
graph was set in the screen when divided.) "Portrait" and "Landscape" set the
print orientation.

2. Print range
Select the waveform section to print.
If you select "Display" the section currently displayed on the screen is printed.
For "All" all sections set in "Set Waveform Display Range" for the screen are
printed.
For "Selection" you can select a print range from any section, from choices
"Head", "Tail", "Cursor A", or "Cursor B". Unless both cursors A and B are
displayed, you cannot select "Selection".

3. Time-axis zoom
If you select "Same to screen" the waveform is printed with the same
magnifying factor as the graph being displayed on the screen. If the print range
does not fit onto one page, the waveform is printed on multiple pages.
If you select "Fit to page" the time-axis magnifying factor is automatically
adjusted so that the print range fits in one page.
If you select "each 1 DIV" or "each 5 DIV" in "New Page" setting, pages are
changed every 1 DIV units or every 5 DIV units, respectively. You cannot
select this setting if the time-axis magnifying factor is set to "Fit to page".

4. Specify margins, Set 1 DIV to 1 cm
If you select "Specify margins" you can specify the left, top, right, and bottom
margins in mm units. The graph is shrunk when printed, according to the set
dimensions of margins. Because the grids are adjusted to square shapes when
printing XY waveforms, margins may become larger than you set.
If you select "Set 1 DIV to 1 cm" grids are printed in 1 cm units.

* Depending on the printer used, the waveform may not fit in the printable
range, and edges may not be printed. Please note that grids can be printed in 1
cm units only with A4 or A3 paper sizes. When printing to other page sizes,
select "Specify margins" and set the margins before printing.

5. Margins
Set the Left, Top, Right, and Bottom margins in mm units.

6. Grid type
Select the type of grid from the choices "OFF", "Standard", "Detail", or "Time-
axis". (When printing XY waveforms, you can select "OFF", "Standard", or
"Detail".)
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7. Gauge/0 Position comment

10.

11.

12.

13.

14.

15.

16.

17.

18.

For the type of gauge, you can select "Upper/Lower", "Detail", "0 Pos
comment", or "U/L + Opos". If you select "Upper/Lower" only the upper/lower-
limit values on each channel are printed. Although there are many channels,
the gauges can be compact. If you select "Detail" the upper/lower limit values
and each scale value are printed. Since one gauge per channel is printed, the
greater the number of channels, the narrower the print range of the waveform.
For "0 pos comment", comments are printed in the zero position of each
channel.

For "UIL + 0 pos", both upper/lower-limit values and comments are printed.
For "Max", set the maximum number of detail gauges you want to attach to
one graph. If the graph contains more channels than set here, a set number of
detail gauges is printed in the order of channel priority, starting with the
highest. However, depending on the selected print format, the number of detail
gauges printed may be fewer than that set.

. Channel marker

Specify how the display mode for the channel markers for the analog, pulse
and logic waveforms to be printed. Select "OFF", "CH Number", or "Comment".
If a comment character string is not set for a channel although "Comment" is
selected, "CH Number" is printed for that channel.

Header

Specify the information you want to include in the header. Select
"Measurement Info", "Info. + Title Comment", or "Info. + File Name".

Channel info.

Specify whether you want to print channel information (e.g., range and display
magnifying factor). Select "ON" or "OFF".

Marker Value

Specify whether you want to print measurement value at cursor A and B,
Event Marker respective positions. Select "OFF", "Cursor", "Event Marker", or
"Both".

Printer

Displays the set printer dialog box.

Preview

A print preview is displayed according to the current detail print settings.
Print

Displays the print dialog box to let you begin printing.

Advanced

Displays the set detail dialog box, allowing you to set the lines and character
fonts of graphs.

Default

Initialize the detailed print setting.

OK

Click OK to finish entering settings.

Cancel

The "Waveform Detail Print Settings" dialog box is closed, without saving the
changes you entered just now. (If you used Preview to preview the print image,
changes made by that point are applied. Selecting Cancel after preview will
not restore the original settings in place before the preview.)
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Setting detail

Click the "Advanced" button in the "Waveform Detail Print Settings" dialog
box to display the "Advanced Settings" dialog box, allowing you to set the
lines and character fonts of graphs.

Each item in this dialog box is explained below.
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. Print color

Select from Color, Grayscale, or Black and white.

. Specify part

Select the part of the graph you want to set. Set the following items for the
part selected here.

. Line width

Set the line widths of waveforms and grids.

. Line type

Specify how you want XY waveforms to be printed (dot, line, or marker)
and how you want the grid border, vertical line, and horizontal line to be
printed (solid or dotted line).

. Font

Click the "Font" button to display the font dialog box. Select a font.

. Color

Clicking the "Color" button to display the color dialog box.
Select a color.

. Set line width and color on each channel

This setting item is displayed when you selected "Analog waveform", "Pulse
waveform", "Logic waveform", or "XY waveform" in the setting item "ltem".
Select the check box labeled "Set line width and color of each CH", and set
the line width and color for each channel. If this check box is deselected, the
waveform is printed with the same line width and color as those on the
screen.

. OK

Click OK to finish entering the settings.

. Cancel

The dialog box is closed without saving the changes just entered.
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6.3 Logging Printing

6.3.1 Logging Printing

While the logging window of the waveform file you want to print is active,
click [File] on the menu bar and choose [Logging Print]. The "Print" dialog
box will then appear. Complete the printer settings and click the <OK>
button. The printer will start printing using the current logging print settings.

6.3.2 Logging print preview

While the logging window of the waveform file you want to preview is
active, click [File] on the menu bar, then choose [Logging Print Preview]. A
preview will be displayed according to current logging print settings.

6.3.3 Logging print settings

Click [File] on the menu bar, then choose [Page Settings] to display the
"Logging Print Settings" dialog box. The settings made in this dialog box
will be applied to the logging printing of all waveform files. Parameters on
the "Logging Print Settings" dialog box are following.

Logging Print Settings E

1 Paper directioniz
o Partrait; " Landscape | Font... |
3~ Margir( mrn ]
Left:

Top:

Battarn :

Right

|5 Preview I * Frirt... |
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1. Orientation
Set the page orientation. Choose [Portrait] or [Landscape].
2. Font
Click the <Font> button to open the "Font" dialog box. Select a printing
font.
3. Margins
Set the Left, Right, Top, and Bottom margins in units of 1 mm.
4. Printer
Display the "Set Printer" dialog box.

Frinker...
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. Preview

A print preview is displayed according to the current logging print settings.
. Print

Displays the print dialog box to let you begin printing.

. OK

Click OK to finish entering settings.

. Cancel

The dialog box is closed, without saving the changes you entered just now.
(If you used Preview to preview the print image, changes made by that point
are applied. Selecting Cancel after preview will not restore the original
settings in place before the preview.)
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